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ªÖÏÄ 

¢Ŝƴǘƻ tǊǻǾƻŘŎŜ ǇǊƻŘǳƪǘŜƳ aƛŎǊƻǎƻŦǘϯ 9ȄǇǊŜǎǎƛƻƴϯ ²Ŝō ǾłƳ Ƴł ǇƻƳƻŎƛ ȊƝǎƪŀǘ ǇǌŜƘƭŜŘ ƻ ƧŜƘƻ 

ǾƭŀǎǘƴƻǎǘŜŎƘ ŀ ƻǾŠǌƛǘ ǾƘƻŘƴƻǎǘ ƧŜƘƻ ƴłƪǳǇǳΦ  

½ƪǳǑŜōƴƝ ǾŜǊȊƛ ƴŀ 60 dƴƝ ǎƛ ƳǻȌŜǘŜ ǎǘłƘƴƻǳǘ ƴŀ ŀŘǊŜǎŜ Υ 

http://www.microsoft.com/products/expression/en/expression-web/free-trial.mspx. 

wƻŘƛƴŀ ǇǊƻŘǳƪǘǻ aƛŎǊƻǎƻŦǘ 9ȄǇǊŜǎǎƛƻƴ ƧŜ ǳǊőŜƴŀ ǇǊƻŦŜǎƛƻƴłƭƴƝƳ ŘŜǎƛƎƴŞǊǻƳΣ ƪǘŜǌƝ ŎƘǘŠƧƝ ǾȅǘǾłǌŜǘ 

ƎǊŀŦƛŎƪƻǳ ǇƻŘƻōǳ ŀǇƭƛƪŀŎƝ ŀ ǇǊƻǎǘǌŜŘƝ ȊŀƭƻȌŜƴȇŎƘ ƴŀ ǘŜŎƘƴƻƭƻƎƛƝŎƘ ǎǇƻƭŜőƴƻǎǘƛ aƛŎǊƻǎƻŦǘΦ 

.ŜȊ ƻƘƭŜŘǳ ƴŀ ǘƻΣ ȊŘŀ ƧŜ ƳƝǎǘŜƳ ǳǊőŜƴƝ ŘŜǎƪǘƻǇ ƴŜōƻ ǿŜōΣ ǇǊƻŘǳƪǘȅ ǊƻŘƛƴȅ 9ȄǇǊŜǎǎƛƻƴ ǇƻƳłƘŀƧƝ 

ǇǌŜƪƭŜƴƻǳǘ ƴŜƻōǎŀȊŜƴȇ ǇǊƻǎǘƻǊ ƴŀ ǇƻƳŜȊƝ ƳŜȊƛ ǇǊŀŎƝ ƴłǾǊƘłǌǻ ŀ ǇǊƻƎǊŀƳłǘƻǊǻΦ ¢ƛ ǎŜ Ǉŀƪ ƳƻƘƻǳ 

ǎǇƻƭŜőƴŠ ǇƻŘƝƭŜǘ ƴŀ ƴłǾǊƘǳ ŀ ǾȇǾƻƧƛ ŀǇƭƛƪŀŎƝ ŀ ǿŜōƻǾȇŎƘ ǎǘǊłƴŜƪ ǇƻǎǘŀǾŜƴȇŎƘ ƴŀ ǘŜŎƘƴƻƭƻƎƛƝŎƘ 

Microsoft. 

¢Ŝƴǘƻ ŎƝƭ ƧŜ ǇǊƻ aƛŎǊƻǎƻŦǘ ƻǇǊŀǾŘǳ ǾŜƭƳƛ ŘǻƭŜȌƛǘȇ ŀ ²ƛƴŘƻǿǎ ±ƛǎǘŀ ƛ нллт aƛŎǊƻǎƻŦǘ hŦŦƛŎŜ {ȅǎǘŜƳ 

Ƨǎƻǳ ǳƪłȊƪƻǾȇƳ ǇǌƝƪƭŀŘŜƳΣ őŜƘƻ ƭȊŜ Ǿ ǘƻƳǘƻ ǎƳŠǊǳ ŘƻǎłƘƴƻǳǘΦ YƻƳōƛƴŀŎŜ ƴłǎǘǊƻƧǻ 9ȄǇǊŜǎǎƛƻƴ 

pro desigƴŞǊȅ ŀ ±ƛǎǳŀƭ {ǘǳŘƛƻ нллр ǇǊƻ ǇǊƻƎǊŀƳłǘƻǊȅ ȊƴŀƳŜƴł ǇƻőłǘŜƪ ƴƻǾŞ ŞǊȅ ǾŜ ǾȇǾƻƧƛ 

ǎƻŦǘǿŀǊǳ ŀ ǿŜōƻǾȇŎƘ ǎǘǊłƴŜƪΦ 

http://www.microsoft.com/products/expression/en/expression-web/free-trial.mspx


4  PǊǻǾƻŘŎŜ ǇǊƻŘǳƪǘŜƳ 

0ĠÅÄÓÔÁÖÕÊÅÍÅ %ØÐÒÅÓÓÉÏÎ 7ÅÂ 

Microsoft Expression Web ƧŜ ǳǾłŘŠƴ ƴŀ ǘǊƘ Ƨŀƪƻ ǇǊǾƴƝ ȊŜ ǎŀŘȅ ƴƻǾȇŎƘ ƴłǎǘǊƻƧǻ ǇǊƻ ǇǊƻŦŜǎƛƻƴłƭƴƝ 

ŘŜǎƛƎƴ ƴŀȊǾŀƴŞ Microsoft ExpressionΦ ¢Ŝƴǘƻ ǇǊƻŘǳƪǘ ǎƛŎŜ ǳƳƻȌƶǳƧŜ Ȋ ŘǻǾƻŘǻ ȊǇŠǘƴŞ ƪƻƳǇŀǘƛōƛƭƛǘȅ 

ŜŘƛǘƻǾŀǘ ǾŠǘǑƛƴǳ ŜȄƛǎǘǳƧƝŎƝŎƘ ǎǘǊłƴŜƪ ȊŀƭƻȌŜƴȇŎƘ ƴŀ CǊƻƴǘtŀƎŜ нллоΣ ǘƝƳ ǾǑŀƪ ǾŜǑƪŜǊł ǇƻŘƻōƴƻǎǘ 

ƪƻƴőƝΦ WŜŘƴł ǎŜ ƻ ȊŎŜƭŀ ƴƻǾȇ ǇǊƻŘǳƪǘΣ ƧŜƘƻȌ ǾȅƪǊŜǎƭƻǾŀŎƝ ƧłŘǊƻ ǇǌŜǎƴŠ ƛƴǘŜǊǇǊŜǘǳƧŜ ƪƽŘ ȊŀƭƻȌŜƴȇ ƴŀ 

ǎƻǳőŀǎƴŞƳ ǎǘŀƴŘŀǊŘǳ ·I¢a[Φ 

YƻƳǳƴƛǘǳ ǇǊƻŦŜǎƛƻƴłƭƴƝŎƘ ƴłǾǊƘłǌǻ ǿŜōǳ ƧƛǎǘŠ ƴŀŘŎƘƴŜΣ ȌŜ ƧŜ Expression Web ȊŀƳŠǌŜƴ ƴŀ ǘǾƻǊōǳ 

ǎǘǊłƴŜƪ ȊŀƭƻȌŜƴȇŎƘ ƴŀ ǎǘŀƴŘŀǊŘŜŎƘ ǎ ǾȅǳȌƛǘƝƳ ǾǑŜŎƘ ŘƴŜǎ ŘƻǇƻǊǳőƻǾŀƴȇŎƘ ǘŜŎƘƴƻƭƻƎƛƝΣ Ƨŀƪƻ Ƨǎƻǳ 

XHTML, CSS, XML a XSLT. 

tǊŀŎƻǾƴƝ ǇǊƻǎǘǌŜŘƝ ǇƻǎƪȅǘǳƧŜ ƪƻƳǇƭŜǘƴƝ ƴŀōƝŘƪǳ ŦǳƴƪŎƝ ǇǊƻ ǇǊƻŦŜǎƛƻƴłƭƴƝ ŘŜǎƛƎƴ ŀ ŘłǾł ǳȌƛǾŀǘŜƭƛ 

Ǉǌƛ ǾƛȊǳłƭƴƝƳ ƴłǾǊƘǳ ƧƛǎǘƻǘǳΣ ȌŜ ǾȅǘǾłǌŜƴȇ ƪƽŘ ōǳŘŜ ōŜȊŎƘȅōƴȇ ŀ ǵőŜƭƴȇΦ 

¢ƻ ǾǑŜ ŀ ƴŀǾƝŎ ǎŎƘƻǇƴƻǎǘ ǾȅǳȌƝǾŀǘ Ǉǌƛ ƴłǾǊƘǳ ǿŜōƻǾȇŎƘ ŀǇƭƛƪŀŎƝ !{tΦb9¢ нΦл ȊƴŀƳŜƴłΣ ȌŜ ǎŜ 

Expression Web ǳǇƭŀǘƴƝ Ƨŀƪƻ ǾȅƴƛƪŀƧƝŎƝ ƴłǎǘǊƻƧ ŘƴŜǎ ƛ Ǿ ōǳŘƻǳŎƴǳΦ 
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+ÏÍÕ ÊÅ %ØÐÒÅÓÓÉÏÎ 7ÅÂ ÕÒéÅÎ 

Expression Web ǾȅǳȌƛƧƝ ȊłƪŀȊƴƝŎƛ Ǉƻ ŎŜƭŞƳ ǎǾŠǘŠ ƪ ǑƛǊƻƪŞƳǳ ǎǇŜƪǘǊǳ őƛƴƴƻǎǘƝ Ǿ ǊłƳŎƛ ǇǊƻŎŜǎǳ 

ƴłǾǊƘǳ ǿŜōǳΦ hōƭŀǎǘƛ ƧŜƧƛŎƘ ȊłƧƳǳ ǎŜ ŘŀƧƝ ǊƻȊőƭŜƴƛǘ ȊƘǊǳōŀ Řƻ ǘŠŎƘǘƻ ƪŀǘŜƎƻǊƛƝΥ 

Á ¦ȌƛǾŀǘŜƭǎƪŞ ǊƻȊƘǊŀƴƝ ǿŜōƻǾȇŎƘ ǎǘǊłƴŜƪ  

Á ±ȇǾƻƧ ǿŜōƻǾȇŎƘ ŀǇƭƛƪŀŎƝ 

Á CSS 

Á tǌƝǎǘǳǇƴƻǎǘ 

Á tƻŘǇƻǊŀ ƴłǊƻŘƴƝŎƘ ǇǊƻǎǘǌŜŘƝ 

5ĿÉÖÁÔÅÌÓËï ÒÏÚÈÒÁÎþ ×ÅÂÏÖĻÃÈ ÓÔÒÜÎÅË 

¢ȅǘƻ ǳȌƛǾŀǘŜƭŜ ǇƻǘŠǑƝ ǇǌƝǎǘǳǇ ƪ ŘŜǎƛƎƴǳ ȊŀƭƻȌŜƴȇ ƴŀ ǎǘŀƴŘŀǊŘŜŎƘΦ tǌƛ ǾƛȊǳłƭƴƝƳ ǾȅǘǾłǌŜƴƝ ǎǘǊłƴŜƪ ǎŜ 

mohou ǎǇƻƭŜƘƴƻǳǘ ƴŀ ǘƻΣ ȌŜ ƻŘǇƻǾƝŘŀƧƝŎƝ ƪƽŘΣ ƪǘŜǊȇ 9ȄǇǊŜǎǎƛƻƴ ²Ŝō ǾȅǘǾƻǌƝΣ ǇƭƴŠ ŘƻŘǊȌǳƧŜ 

ƳƻŘŜǊƴƝ ǎǘŀƴŘŀǊŘȅ ²о/Σ Ƨŀƪƻ Ƨǎƻǳ ·I¢a[Σ /{{Σ ·a[ ŀ ·{[¢Φ 

6ĻÖÏÊ ×ÅÂÏÖĻÃÈ ÁÐÌÉËÁÃþ 

tǌƛ ǘǾƻǊōŠ ǿŜōƻǾȇŎƘ ŀǇƭƛƪŀŎƝ ǎŜ ǇƻǳȌƝǾł ŎŜƭł ǌŀŘŀ ǘŜŎƘƴƻƭƻƎƛƝΦ YŀȌŘł Ȋ ƴƛŎƘ ǾȅȌŀŘǳƧŜΣ ŀōȅ ǎŜ 

ŘŜǎƛƎƴŞǊ ǾȅǇƻǌłŘŀƭ ǎ ƪǳǎȅ ǎƭƻȌƛǘŞƘƻ ƪƽŘǳΣ ƪǘŜǊȇ ǇŀǘǌƝ ǎǇƝǑ Řƻ ǇǊƻƎǊŀƳłǘƻǊǎƪŞƘƻ ǎǾŠǘŀΦ 9ȄǇǊŜǎǎƛƻƴ 

²Ŝō ǾȅǳȌƝǾł ǎŎƘƻǇƴƻǎǘƛ !{tΦb9¢ нΦл ŀ ŘƻǾƻƭǳƧŜ ŘŜǎƛƎƴŞǊǻƳΣ ŀōȅ ǎƛ ǾȅōƝǊŀƭƛ Ȋ ōƻƘŀǘŞ ƴŀōƝŘƪȅ 

ƻǾƭłŘŀŎƝŎƘ ǇǊǾƪǻΣ ǇǌŜǘŀƘƻǾŀƭƛ ƧŜ ƳȅǑƝ ƴŀ ǇǊŀŎƻǾƴƝ ǇƭƻŎƘǳ ŀ ŦƻǊƳłǘƻǾŀƭƛ ƧŜΣ ŀƴƛȌ ōȅ ǇƻǘǌŜōƻǾŀƭƛ 

ǇǊŀŎƻǾŀǘ ǎ ƪƽŘŜƳ ƴŀ ǇƻȊŀŘƝΦ tǊƻƧŜƪǘ ǎŜ ƳǻȌŜ ǎǘŠƘƻǾŀǘ ƻŘ ǾȇǾƻƧłǌǻ ƪ ŘŜǎƛƎƴŞǊǻƳ ǿŜōǳ ǘŀƪ őŀǎǘƻΣ 

Ƨŀƪ ƧŜ ȊŀǇƻǘǌŜōƝΣ ƪŘȅȌ ǾȇǾƻƧłǌƛ ǇƻǳȌƝǾŀƧƝ ±ƛǎǳŀƭ ²Ŝō 5ŜǾŜƭƻǇŜǊ ŀ ±ƛǎǳŀƭ {ǘǳŘƛƻ нллр ŀ ŘŜǎƛƎƴŞǌƛ 

Expression Web. 

+ÁÓËÜÄÏÖï ÓÔÙÌÙ ɉ#33Ɋ 

WŜŘƴƝƳ Ȋ ƘƭŀǾƴƝŎƘ ŎƝƭǻ /{{ ƧŜ ƻŘŘŠƭƛǘ ƴłǾǊƘ ǾȊƘƭŜŘǳ ŀ ƻōǎŀƘΦ 9ȄǇǊŜǎǎƛƻƴ ²Ŝō ǇƭƴŠ ǇƻŘǇƻǊǳƧŜ 

ŘŜǎƛƎƴ ǎ ǾȅǳȌƛǘƝƳ /{{Φ błǾǊƘłǌǎƪŞ ŀƪŎŜ ǇǊƻǾŜŘŜƴŞ ǇƻƳƻŎƝ ǾƛȊǳłƭƴƝŎƘ ƴłǎǘǊƻƧǻ Ƨǎƻǳ ǇǌŜǇǎłƴȅ Řƻ 

ƪŀǎƪłŘƻǾȇŎƘ ǎǘȅƭǻ Ǿ ǎƻǳƭŀŘǳ ǎ ǾŜǊȊƝΣ ƪǘŜǊƻǳ ǎƛ ŘŜǎƛƎƴŞǊ ǾȅōǊŀƭΦ ±ȇǎƭŜŘƴł ǇǊŀǾƛŘƭŀ ƭȊŜ Ǉŀƪ ǎƭǳőƻǾŀǘ 

a ǎǇǊŀǾƻǾŀǘ ǇǊƻǎǘǌŜŘƴƛŎǘǾƝƳ ǎǇŜŎƛŀƭƛȊƻǾŀƴŞƘƻ ǇŀƴŜƭǳΦ  

0ĠþÓÔÕÐÎÏÓÔ 

/Ŝƭł ǌŀŘŀ ǳȌƛǾŀǘŜƭǻ ǎŜ ȊŀƳŠǌǳƧŜ ƪƻƴƪǊŞǘƴŠ ƴŀ ǇƻǎǘǳǇȅ ǇƻǘǌŜōƴŞ ƪ ōǳŘƻǾłƴƝ ǿŜōƻǾȇŎƘ ǎǘǊłƴŜƪ 

ǎǇƭƶǳƧƝŎƝŎƘ ǇƻȌŀŘŀǾƪȅ ƴŀ ǇǌƝǎǘǳǇƴƻǎǘΦ ¢Ŝƴǘƻ ŎƝƭ ōȅ ƳŠƭ ƳƝǘ ƪŀȌŘȇΣ ƪŘƻ ƴŀǾǊƘǳƧŜ ǿŜōƻǾŞ ǎǘǊłƴƪȅΣ 

ǇǊƻǘƻ ǎŜ ƴŀ ƴŠƳ ǇƻŘƝƭƝ ƛ 9ȄǇǊŜǎǎƛƻƴ ²ŜōΦ tǌŜōƝǊł Ȋŀ ǳȌƛǾŀǘŜƭŜ őłǎǘ ǇǊłŎŜ ŀ ǾȅǘǾłǌƝ ǎǘǊłƴƪȅΣ ƪǘŜǊŞ 

ǾȅƘƻǾǳƧƝ ǎǘŀƴŘŀǊŘǻƳ ²о/Φ tǊƻƎǊŀƳ ǎƛ ǘŀƪŞ ǾȅȌłŘł ǇƻǘǌŜōƴŞ ƛƴŦƻǊƳŀŎŜ ǘŀƳΣ ƪŘŜ ƧŜ ǘƻ ƴǳǘƴŞΦ 

V ǊƻȊƳŀƴƛǘȇŎƘ ǇǌŜƘƭŜŘŜŎƘ Ƨǎƻǳ ƪ ŘƛǎǇƻȊƛŎƛ ƘȅǇŜǊǘŜȄǘƻǾŞ ƻŘƪŀȊȅ ƴŀ ǎǘǊłƴƪȅ ǘȇƪŀƧƝŎƝ ǎŜ ǊǻȊƴȇŎƘ 

ǎǘŀƴŘŀǊŘǻΣ ƪŘŜ ƭȊŜ ȊƝǎƪŀǘ ƛƴŦƻǊƳŀŎŜ ƻ ƴŜǾȅƘƻǾǳƧƝŎƝŎƘ ƳƝǎǘŜŎƘΦ 

0ÏÄÐÏÒÁ ÎÜÒÏÄÎþÃÈ ÐÒÏÓÔĠÅÄþ 

tƻǘǌŜōŀ ōǳŘƻǾŀǘ ǿŜōƻǾŞ ǎǘǊłƴƪȅΣ ƪǘŜǊŞ ŦǳƴƎǳƧƝ Ǿ ǊǻȊƴȇŎƘ ƧŀȊȅŎƝŎƘ ŀ ƪǳƭǘǳǊłŎƘΣ ǎǘŀƭŜ ƴŀǊǻǎǘł 

a ǳȌƛǾŀǘŜƭŞ ǇƻǘǌŜōǳƧƝ ǇǊƻƎǊŀƳȅΣ ƪǘŜǊŞ ǳƳƝ ǇǊŀŎƻǾŀǘ ǎŜ ȊƴŀƪƻǾƻǳ ǎŀŘƻǳ ¦¢C-8 (Unicode) a s texty, 

ƧŜȌ ǎŜ ƴŜőǘƻǳ ƧŜƴ ȊƭŜǾŀ ŘƻǇǊŀǾŀΦ 2ŀǎǘƻ ǎŜ ǎǘłǾłΣ ȌŜ őƭŜƴƻǾŞ ƧŜŘƴƻƘƻ ƴłǾǊƘłǌǎƪŞƘƻ ǘȇƳǳ ƳƭǳǾƝ 

ǊǻȊƴȇƳƛ ƧŀȊȅƪȅ ŀ ƪƭƝőŜƳ ƪ ƧŜƧƛŎƘ ǵǎǇŠŎƘǳ ƧŜ ƳƝǘ ƧŜŘŜƴ ƴłǎǘǊƻƧΣ ƪǘŜǊȇ ǘƻ ǾǑŜŎƘƴƻ ȊǾƭłŘƴŜΦ 



6  PǊǻǾƻŘŎŜ ǇǊƻŘǳƪǘŜƳ 

(ÌÁÖÎþ ideje Expression Webu 

.ÏÖÜ ïÒÁȟ ÎÏÖĻ ÎÜÓÔÒÏÊ 

tƻǳȌƝǾłƴƝ ǾȇƪƻƴƴȇŎƘ ƴłǾǊƘłǌǎƪȇŎƘ ƴłǎǘǊƻƧǻ ŀ ǇƻŘƻƪŜƴ ǵƭƻƘ ƪ ǊȅŎƘƭŞƳǳ ȊŀőƭŜƴŠƴƝ Řŀǘ ·a[ ǎƴƛȌǳƧŜ 

ǎƭƻȌƛǘƻǎǘ ŀ ǳǎƴŀŘƶǳƧŜ ƛƴǘŜƎǊŀŎƛ ŘŀǘΦ ²ŜōƻǾƝ ŘŜǎƛƎƴŞǌƛ ŀ ǇǊƻƎǊŀƳłǘƻǌƛ ƳƻƘƻǳ ǵȊŎŜ ǎǇƻƭǳǇǊŀŎƻǾŀǘ 

ŘƝƪȅ ǾȅƴƛƪŀƧƝŎƝ ǇƻŘǇƻǌŜ XML, ASP.NET a XHTML, kterou poskytuje Expression Web i Visual Studio. 

+ÒÜÓÎĻ ÕÖÎÉÔĠ É ÎÁÖÅÎÅË 

5ŜƧǘŜ Ǿƻƭƴȇ ǇǊǻŎƘƻŘ ǎǾȇƳ ǘǾǻǊőƝƳ ƴłǇŀŘǻƳ ŀ ƻȌƛǾǘŜ ǎǾŞ ǿŜōƻǾŞ ǎǘǊłƴƪȅ ǇƻƳƻŎƝ ǇǊƻǇǊŀŎƻǾŀƴȇŎƘ 

ƪŀǎƪłŘƻǾȇŎƘ ǎǘȅƭǻΦ { ǾƛȊǳłƭƴƝƳƛ ƴłǾǊƘłǌƛΣ ǎǇŜŎƛŀƭƛȊƻǾŀƴȇƳƛ ǇƻŘƻƪƴȅ ǵƭƻƘ ŀ ǇŀƴŜƭȅ ƴłǎǘǊƻƧǻ ƳǻȌŜǘŜ 

ǇǌŜǎƴŠ ƻǾƭłŘŀǘ ǾȊƘƭŜŘ ŀ ŦƻǊƳłǘƻǾłƴƝ ǎǘǊłƴŜƪΦ 

2ÅÓÐÅËÔÏÖÜÎþ ÓÔÁÎÄÁÒÄĳ 

.ǳŘǳƧǘŜ Ŏƻ ƴŜƧƭŜǇǑƝ ŘȅƴŀƳƛŎƪŞΣ ƛƴǘŜǊŀƪǘƛǾƴƝ ǎǘǊłƴƪȅΣ ƪǘŜǊŞ ǇƭƴŠ ǾȅǳȌƝǾŀƧƝ ƳƻȌƴƻǎǘƝ ǿŜōǳΦ 

±ŜǎǘŀǾŠƴł ǇƻŘǇƻǊŀ ƳƻŘŜǊƴƝŎƘ ǿŜōƻǾȇŎƘ ǎǘŀƴŘŀǊŘǻ ǳǎƴŀŘƶǳƧŜ ƻǇǘƛƳŀƭƛȊŀŎƛ ǎǘǊłƴŜƪΣ ŀōȅ ōȅƭȅ 

ŘƻōǌŜ ǇǌƝǎǘǳǇƴŞ ŀ ƪƻƳǇŀǘƛōƛƭƴƝ ǎ ǊǻȊƴȇƳƛ ǇǊƻƘƭƝȌŜőƛΦ 



 

Microsoft Expression Web  7 

0ĠÅÈÌÅÄ ÐÏÄÌÅ ÆÕÎËÃþ 

7ÅÂÏÖï ÓÔÒÜÎËÙ ÚÁÌÏĿÅÎï ÎÁ ÓÔÁÎÄÁÒÄÅÃÈ 
²ŜōƻǾŞ ǎǘǊłƴƪȅ Ƨǎƻǳ ŀǳǘƻƳŀǘƛŎƪȅ ǾȅǘǾłǌŜƴȅ ƴŀ ȊłƪƭŀŘŠ /{{Σ ǾȅƘƻǾǳƧƝ ǎǘŀƴŘŀǊŘǳ ·I¢a[ мΦл 

¢Ǌŀƴǎƛǘƛƻƴŀƭ ŀ ƭŞǇŜ ǎǇƻƭǳǇǊŀŎǳƧƝ ǎ ǊǻȊƴȇƳƛ ǇǊƻƘƭƝȌŜőƛΣ ŎƻȌ ǳǎƴŀŘƶǳƧŜ ƧŜƧƛŎƘ ƴŀǎŀȊƻǾłƴƝ ŀ ǵŘǊȌōǳΦ 

bŀǎǘŀǾŜƴƝ ǎŎƘŞƳŀǘ ƭȊŜ ƪƻƴŦƛƎǳǊƻǾŀǘ ǘŀƪΣ ŀōȅ ǇƻŘǇƻǊƻǾŀƭŀ ǾǑŜŎƘƴȅ ƪƻƳōƛƴŀŎŜ 

I¢a[κ·I¢a[κ{ǘǊƛŎǘκ¢ǊŀƴǎƛǘƛƻƴŀƭκCǊŀƳŜǎŜǘ ŀ /{{ мΦлκнΦлκнΦм ǎ ƻƘƭŜŘŜƳ ƴŀ ǎŎƘŞƳŀǘŀ ƪƻƴƪǊŞǘƴƝŎƘ 

ǇǊƻƘƭƝȌŜőǻΦ {ǘǊłƴƪȅ ƭȊŜ ƻǾŠǌƻǾŀǘ ǇǊƻǎǘǌŜŘƴƛŎǘǾƝƳ ǊŜǇƻǊǘǻ ƻ ƪƻƳǇŀǘƛōƛƭƛǘŠ ŀ ǇǌƝǎǘǳǇƴƻǎǘƛ ǇƻŘƭŜ 

Section 508 a W3C Content Accessibility Guidelines (WCAG). 

Soulad s XHTML ς 9ȄǇǊŜǎǎƛƻƴ ²Ŝō ǇƭƴŠ ǇƻŘǇƻǊǳƧŜ ·I¢a[Σ ǇǊƻǘƻ ƧŜ ǎƴŀŘƴŞ ƴŀǾǊƘƻǾŀǘ ǎǘǊłƴƪȅ 

ǾȅƘƻǾǳƧƝŎƝ ǎƻǳőŀǎƴȇƳ ƴłǊƻőƴȇƳ ǎǘŀƴŘŀǊŘǻƳΦ  

tƭƴł ǇƻŘǇƻǊŀ ǎŎƘŞƳŀǘ ς 9ȄǇǊŜǎǎƛƻƴ ²Ŝō ŀǳǘƻƳŀǘƛŎƪȅ ǾȅǘǾƻǌƝ ƻŘǇƻǾƝŘŀƧƝŎƝ ƪƽŘ ǇƻŘƭŜ ǘƻƘƻΣ ƧŀƪŞ 

ǎŎƘŞƳŀ ǎƛ ǾȅōŜǊŜǘŜΣ ŀ ŦǳƴƪŎŜ ǇǊƻ ƪƻƴǘǊƻƭǳ ƪƻƳǇŀǘƛōƛƭƛǘȅ ȊǾȇǊŀȊƴƝ ǾǑŜŎƘƴȅ ƴŜǾȅƘƻǾǳƧƝŎƝ ǇǊǾƪȅΦ 

hǾŠǌƻǾłƴƝ ǎǘŀƴŘŀǊŘǻ Ǿ ǊŜłƭƴŞƳ őŀǎŜ ς ½ǇŠǘƴł ǾŀȊōŀ ƻ ǇƻǊǳǑŜƴƝ ǎǘŀƴŘŀǊŘǻ ƳǻȌŜ ōȇǘ ƻƪŀƳȌƛǘł ǳȌ 

ōŠƘŜƳ ǇǊƻŎŜǎǳ ƴłǾǊƘǳΣ ŀ ǘƻ ŀǙ ƧŜ ȊƻōǊŀȊŜƴ ŘŜǎƛƎƴΣ ƴŜōƻ ƪƽŘΦ 

YƻƴǘǊƻƭŀ ǇǌƝǎǘǳǇƴƻǎǘƛ ς ±ŜǎǘŀǾŠƴł ƪƻƴǘǊƻƭŀ ǇǌƝǎǘǳǇƴƻǎǘƛ ǳƳƻȌƶǳƧŜ ȊŀƧƛǎǘƛǘΣ ȌŜ ǿŜōƻǾŞ ǎǘǊłƴƪȅ 

ƻŘǇƻǾƝŘŀƧƝ ǎǘŀƴŘŀǊŘǻƳ ǇǌƝǎǘǳǇƴƻǎǘƛ ǇƻŘƭŜ ²/!D ŀ {ŜŎǘƛƻƴ рлуΦ 

0ÒÏÐÒÁÃÏÖÁÎĻ ÖÚÈÌÅÄ Á ÆÏÒÍÜÔÏÖÜÎþ ÎÁ ÚÜËÌÁÄñ #33 
5Ɲƪȅ ƴŜƧƴƻǾŠƧǑƝƳ ƴłǾǊƘłǌǎƪȇƳ ƴłǎǘǊƻƧǻƳ ƭȊŜ ǳǎǇƻǌłŘłƴƝ ǎǘǊłƴƪȅ ǊƻȊǾǊƘƴƻǳǘ ǇƻƳƻŎƝ ƪŀǎƪłŘƻǾȇŎƘ 

ǎǘȅƭǻ ό/{{ύ ŀ ǇǌŜǎƴŠ ƴŀǎǘŀǾƻǾŀǘ ǇƻȊƛŎŜΣ ǾŜƭƛƪƻǎǘƛΣ ƻƪǊŀƧŜ ŀ ǾȇǇƭƴŠΦ 9ȄǇǊŜǎǎƛƻƴ ²Ŝō ƻōǎŀƘǳƧŜ 

ŘǻƳȅǎƭƴŞ ƧłŘǊƻ ǇǊƻ ƛƴǘŜǊǇǊŜǘŀŎƛ ŀ ǎǇǊłǾǳ ƪŀǎƪłŘƻǾȇŎƘ ǎǘȅƭǻΦ aǻȌŜǘŜ ǎƛ ǘŜŘȅ ǇǌƝƳƻ ōŠƘŜƳ ƴłǾǊƘǳ 

ǾȅȊƪƻǳǑŜǘ ǊǻȊƴŞ ƪŀǎƪłŘƻǾŞ ǎǘȅƭȅ ŀ Ǉŀƪ ƧŜ ǇǌŜǎǳƴƻǳǘ Řƻ ŜȄǘŜǊƴƝƘƻ ǎƻǳōƻǊǳ ǎŜ ǎǘȅƭȅΦ tǌƛ ǇǊłŎƛ Ǿ ƪƽŘǳ 

ŦǳƴƎǳƧƝ ǇƻƳǻŎƪȅ Ǉǌƛ ǇǎŀƴƝ ŀ LƴǘŜƭƭƛ{ŜƴǎŜϯ ŀ ŎŜƭł ǇǊłŎŜ ƧŜ ǘŜŘȅ ǊȅŎƘƭł ŀ ŜŦŜƪǘƛǾƴƝΦ 

tǊƻŦŜǎƛƻƴłƭƴƝ ǇǊŀŎƻǾƴƝ ǇǊƻǎǘǌŜŘƝ ς aƻŘŜǊƴƝ ǇǊƻŦŜǎƛƻƴłƭƴƝ ǎŀŘŀ ƴłǎǘǊƻƧǻ ǇƻƳłƘł ƴŀǾǊƘƻǾŀǘ 

ǇǊǾƻǘǌƝŘƴƝ ǿŜōƻǾŞ ǎǘǊłƴƪȅ ŀ ŀǇƭƛƪŀŎŜΦ ±ȇƪƻƴƴŞ ŀ ǇǌƛǘƻƳ ǎƴŀŘƴƻ ƻǾƭŀŘŀǘŜƭƴŞ ƴłǎǘǊƻƧŜ ŘƻǾƻƭǳƧƝ 

ǇǌƝƳƻ ǇǊŀŎƻǾŀǘ ǎ ƻƪǊŀƧƛ ŀ ǾȇǇƭƴŠƳƛ Ǿ ŎŜƭŞƳ ŘƻƪǳƳŜƴǘǳΦ 

LƴǘŜƭƛƎŜƴǘƴƝ ƴłǾǊƘ ƴŀ ȊłƪƭŀŘŠ ƪŀǎƪłŘƻǾȇŎƘ ǎǘȅƭǻ ς {ƻǳǎǘǌŜřǘŜ ǎŜ ƴŀ ǾƭŀǎǘƴƝ ƴłǾǊƘΣ 9ȄǇǊŜǎǎƛƻƴ 

²Ŝō ǎłƳ ǾȅǘǾƻǌƝ ǇƻǘǌŜōƴȇ ƪƽŘ ƴŀ ȊłƪƭŀŘŠ /{{ ŀ ǳǑŜǘǌƝ ǾłƳ ƻǇŀƪƻǾŀƴƻǳ ǇǊłŎƛΦ 

±ȅƴƛƪŀƧƝŎƝ ƧłŘǊƻ ǇǊƻ ƛƴǘŜǊǇǊŜǘŀŎƛ /{{ ς ±ȇƪƻƴƴŞ ǾŜǎǘŀǾŠƴŞ ƧłŘǊƻ ǇǊƻ ƛƴǘŜǊǇǊŜǘŀŎƛ /{{ ȊŀƧƛǑǙǳƧŜΣ ȌŜ 

Ǉǌƛ ƴłǾǊƘǳ ǾƛŘƝǘŜ ǎǘǊłƴƪǳ ǇǌŜǎƴŠ ǘŀƪΣ Ƨŀƪ ōǳŘŜ ƴŀƪƻƴŜŎ ǾȅǇŀŘŀǘ Ǿ ǇǊƻƘƭƝȌŜőƛΦ 

{ǇǊłǾŀ ǎǘȅƭǻ ǇƻƳƻŎƝ ƳȅǑƛ ς aǻȌŜǘŜ ǎƛ ǾȅȊƪƻǳǑŜǘ ǊǻȊƴŞ ǘȅǇȅ ƴłǾǊƘǳ ǎ ƭƻƪłƭƴƝƳƛ ƪŀǎƪłŘƻǾȇƳƛ ǎǘȅƭȅ 

ŘŀƴŞ ǎǘǊłƴƪȅ ŀ Ǉŀƪ ƧŜ ǎƴŀŘƴƻ ƳȅǑƝ ǇǌŜǎǳƴƻǳǘ Řƻ ŜȄǘŜǊƴƝƘƻ ǎƻǳōƻǊǳ ǎŜ ǎǘȅƭȅΦ  

½ƻōǊŀȊŜƴƝ ǘȅǇǳ {ǘŀƴŘŀǊŘ ƴŜōƻ vǳƛǊƪǎ ς {ǘǊłƴƪȅ Ƨǎƻǳ ǾȅƪǊŜǎƭƻǾłƴȅ ǾŜ ǎǘŀƴŘŀǊŘƴƝƳ ǊŜȌƛƳǳ ƴŜōƻ 

v ƴŜǎǘŀƴŘŀǊŘƴƝƳ ǊŜȌƛƳǳ όvǳƛǊƪǎύ ǇƻŘƭŜ ƴŀǎǘŀǾŜƴƝ Ȋƴŀőƪȅ ŘƻŎǘȅǇŜΣ ŎƻȌ ȊŀǊǳőǳƧŜ Ŏƻ ƴŜƧǾȅǑǑƝ 

ƪƻƳǇŀǘƛōƛƭƛǘǳ ǾȊƘƭŜŘŜƳ ƪ ǇƻǳȌƛǘŞƳǳ ǇǊƻƘƭƝȌŜőƛΦ 

LƴǘŜƭƛƎŜƴǘƴƝ ǇǌŜƧƳŜƴƻǾłƴƝ ǎǘȅƭǳ ς aŜǘŀŘŀǘŀ 9ȄǇǊŜǎǎƛƻƴ ²Ŝōǳ ǳŎƘƻǾłǾŀƧƝ ƛƴŦƻǊƳŀŎŜ ƻ ǇƻǳȌƛǘƝ 

ǎǘȅƭǳΣ ǇǊƻǘƻ ƧŜ ǇǌŜƧƳŜƴƻǾłƴƝ ǎǘȅƭǳ ŘƝƭŜƳ ƻƪŀƳȌƛƪǳΣ ōŜȊ ƴǳǘƴƻǎǘƛ αƴŀƧƝǘ ŀ ƴŀƘǊŀŘƛǘάΦ 



8  PǊǻǾƻŘŎŜ ǇǊƻŘǳƪǘŜƳ 

~ŀōƭƻƴȅ ǎǘǊłƴŜƪ ς wƻȊƧŜřǘŜ ǘƻ ƴŀ Ǉƭƴȇ Ǉƭȅƴ ŘƝƪȅ ǇǊƻŦŜǎƛƻƴłƭƴŠ ƴŀǾǊȌŜƴȇƳ ǑŀōƭƻƴłƳΣ ƪǘŜǊŞ ǇƭƴŠ 

ǾȅƘƻǾǳƧƝ ·I¢a[ ŀ /{{Φ 

tǌŜƘƭŜŘȅ ƻ /{{ ς tƻŘǊƻōƴŞ ǇǌŜƘƭŜŘȅ ƻ ǇƻǳȌƛǘƝ ƪŀǎƪłŘƻǾȇŎƘ ǎǘȅƭǻ Ǿ ǇƻŘƻƪƴŠ wŜǎǳƭǘǎ ǇƻǎƪȅǘǳƧƝ 

ƛƴŦƻǊƳŀŎŜ ƻ ǘƻƳΣ ƴŀ ƪǘŜǊȇŎƘ ǎǘǊłƴƪłŎƘ ōȅƭȅ ƪǘŜǊŞ ǎǘȅƭȅ ǇƻǳȌƛǘȅΦ 

tƻŘƻƪƴƻ ǾƭŀǎǘƴƻǎǘƝ Ȋƴŀőƪȅ ό¢ŀƎ tǊƻǇŜǊǘƛŜǎ) ς ±ŜǑƪŜǊł Ǿȇƪƻƴƴƻǎǘ ƧŀȊȅƪŀ I¢a[ ƧŜ ǾłƳ ƪ ŘƛǎǇƻȊƛŎƛ 

ǇǊƻǎǘǌŜŘƴƛŎǘǾƝƳ ǘƻƘƻǘƻ ǇƻŘƻƪƴŀΣ ƪǘŜǊŞ ǇǌŜƘƭŜŘƴŠ ȊƻōǊŀȊǳƧŜ ǾǑŜŎƘƴȅ ǇƭŀǘƴŞ Ǿƭŀǎǘƴƻǎǘƛ ǾȅōǊŀƴŞ 

ȊƴŀőƪȅΦ 

tǊŜŦŜǊŜƴŎŜ /{{ Ǿ ǊŜȌƛƳǳ ƴłǾǊƘǳ ς YŀȌŘȇ ǳȌƛǾŀǘŜƭ ǎƛ ƳǻȌŜ ǎłƳ Řƻ ŘŜǘŀƛƭǻ ŘƻƭŀŘƛǘΣ ƧŀƪȇƳ ȊǇǻǎƻōŜƳ 

Ƴł 9ȄǇǊŜǎǎƛƻƴ ²Ŝō ƎŜƴŜǊƻǾŀǘ ƪƽŘΦ 

0ĠÉÔÁĿÌÉÖÜ prezentace dat  
Y ǾȅǘǾłǌŜƴƝ ŀ ŦƻǊƳłǘƻǾłƴƝ ǇƻƘƭŜŘǻ ƴŀ ǎǘŀƴŘŀǊŘƴƝ Řŀǘŀ ǾŜ ŦƻǊƳłǘǳ ·a[ ǎƭƻǳȌƝ ǇƻƘƻŘƭƴŞ ƴłǎǘǊƻƧŜ 

ǇǊƻ ǊȅŎƘƭƻǳ ǾƛȊǳŀƭƛȊŀŎƛ ŦƻǊƳłǘƻǾłƴƝΣ ƪǘŜǊŞ ƧŜ ƪƻƴȊƛǎǘŜƴǘƴƝ ǎŜ ȊōȅǘƪŜƳ ǎǘǊłƴƪȅΦ ·tŀǘƘ 9ȄǇǊŜǎǎƛƻƴ 

.ǳƛƭŘŜǊ ŘƻǾƻƭǳƧŜ ōǳŘƻǾŀǘ ƪƻƳǇƭŜȄƴƝ ŘƻǘŀȊȅ ŀ ŘƝƪȅ ǇƻŘǇƻǌŜ ·{[ ¢ǊŀƴǎŦƻǊƳ ό·{[¢ύ ƳƻƘƻǳ ǾȇǎƭŜŘƴł 

Řŀǘŀ ǾȅǇŀŘŀǘ ǇǊłǾŠ ǘŀƪΣ Ƨŀƪ ŎƘŎŜǘŜΦ 5ŀǘŀ ǾŜ ŦƻǊƳłǘǳ ·a[ ƭȊŜ ǘŀƪŞ ƴŀőƝǘŀǘ ŀ ǇǊŜȊŜƴǘƻǾŀǘ 

ǇǊƻǎǘǌŜŘƴƛŎǘǾƝƳ w{{ ƪŀƴłƭǻ ȊŦƻǊƳłǘƻǾŀƴȇŎƘ ǇƻŘƭŜ ǾȊƘƭŜŘǳ ǾŀǑŜƘƻ ǿŜōǳΦ 

tƻƘƭŜŘȅ ƴŀ Řŀǘŀ ·a[ ǑƛǘŞ ƴŀ ƳƝǊǳ ς ±ȅǳȌƝǾŜƧǘŜ ǾȇƪƻƴƴŞ ƴłǎǘǊƻƧŜ ƪ ƴŀǾǊƘƻǾłƴƝ ǾƭŀǎǘƴƝŎƘ ǇƻƘƭŜŘǻ 

ƴŀ ǎǘŀƴŘŀǊŘƴƝ Řŀǘŀ ǾŜ ŦƻǊƳłǘǳ XML a sledujte, jak buŘƻǳ Řŀǘŀ ǾȅǇŀŘŀǘ ƴŀ ǎǘǊłƴƪłŎƘ 

s ƪŀǎƪłŘƻǾȇƳƛ ǎǘȅƭȅΦ 

Podpora XSL Transform (XSLT) ς { ǾȅǳȌƛǘƝƳ ·{[¢ ƳƻƘƻǳ ŘŜǎƛƎƴŞǌƛ ȊǘǾłǊƴƛǘ Řŀǘŀ ǾŜ ŦƻǊƳłǘǳ ·a[ 

v ƭƛōƻǾƻƭƴŞ ǇƻŘƻōŠΣ Ƨŀƪƻǳ ǎƛ ǾȅōŜǊƻǳΣ ŀ ŘƻƪƻƴŎŜ ƛ ŜŘƛǘƻǾŀǘ ǇƻƘƭŜŘȅ ƴŀŘ ƻǎǘǊȇƳƛ ŘŀǘȅΦ 

±ȇƪƻƴƴŞ ȊǇǊŀŎƻǾłƴƝ Řŀǘ ς Y ŘƻƭŀŘŠƴƝ ǾȇǎƭŜŘƴŞ ǇƻŘƻōȅ Řŀǘ ƴŀ ǎǘǊłƴŎŜ ǎƭƻǳȌƝ ƴłǎǘǊƻƧŜ ǇǊƻ ǌŀȊŜƴƝΣ 

ŦƛƭǘǊƻǾłƴƝ ŀ ǇƻŘƳƝƴŠƴŞ ŦƻǊƳłǘƻǾłƴƝΦ 

w{{ ƪŀƴłƭȅ ς ałǘŜ ƳƻȌƴƻǎǘ ǇǊŜȊŜƴǘƻǾŀǘ Řŀǘŀ ǾŜ ŦƻǊƳłǘǳ ·a[ ǇǊƻǎǘǌŜŘƴƛŎǘǾƝƳ w{{ ƪŀƴłƭǻ 

ȊŦƻǊƳłǘƻǾŀƴȇŎƘ Ǿ ǎƻǳƭŀŘǳ ǎŜ ǾȊƘƭŜŘŜƳ ǾŀǑƛŎƘ ǎǘǊłƴŜƪΦ 

6ĻËÏÎÎÜ ÓÅÒÖÅÒÏÖÜ ÔÅÃÈÎÏÌÏÇÉÅ 
½ǳȌƛǘƪǳƧǘŜ ǎƝƭǳ !{tΦb9¢ нΦ ŀ ǇǌŜƳŠƶǘŜ ǎǾŞ ǎǘǊłƴƪȅ ƴŀ ŘȅƴŀƳƛŎƪŞΣ ƛƴǘŜǊŀƪǘƛǾƴƝ ǿŜōƻǾŞ ŀǇƭƛƪŀŎŜΣ 

s integrovanou ǇƻŘǇƻǊƻǳ ǎŜǊǾŜǊƻǾȇŎƘ ŀ ǳȌƛǾŀǘŜƭǎƪȇŎƘ ƻǾƭłŘŀŎƝŎƘ ǇǊǾƪǻ ŀ ōŜȊ ƴǳǘƴƻǎǘƛ 

ǇǊƻƎǊŀƳƻǾŀǘ ǾŀȊōǳ ƴŀ ŘŀǘŀΦ tŀƴŜƭ ƴłǎǘǊƻƧǻ ǇǊƻ ƻǾƭłŘŀŎƝ ǇǊǾƪȅΣ ǇƻŘƻƪƴƻ ǾƭŀǎǘƴƻǎǘƝ ŀ ƳƝǎǘƴƝ 

ƴŀōƝŘƪȅ όŀŎǘƛƻƴ ƳŜƴǳǎύ ǳƳƻȌƶǳƧƝ Ǿ ƳȌƛƪǳ ǾƭƻȌƛǘ ŀ ƴŀƪƻƴŦƛƎǳǊƻǾŀǘ ƻǾƭłŘŀŎƝ ǇǊǾƪȅ !{tΦb9¢Φ ±ȊƻǊƻǾŞ 

ǎǘǊłƴƪȅ όaŀǎǘŜǊ tŀƎŜǎύ !{tΦb9¢ ȊŀǎŜ ŘƻǾƻƭǳƧƝ ǎƴŀŘƴƻ ŀ ǊȅŎƘƭŜ ǇǊƻǾłŘŠǘ ȊƳŠƴȅ ƴŀ ŎŜƭŞ ǎǘǊłƴŎŜΦ 

ASP.NET ς ±ȅǘǾłǌŜƧǘŜΣ ŜŘƛǘǳƧǘŜ ŀ ƴŀǎŀȊǳƧǘŜ ǿŜōƻǾŞ ǎǘǊłƴƪȅ ǇƭƴŠ ƪƻƳǇŀǘƛōƛƭƴƝ ǎ ƴŜƧƴƻǾŠƧǑƝƳ 

ǎǘŀƴŘŀǊŘŜƳ !{tΦb9¢ нΦлΦ hǾƭłŘŀŎƝ ǇǊǾƪȅ !{tΦb9¢ ǎƴŀŘƴƻ ǇǌŜǘłƘƴŜǘŜ ƴŀ ǎǾŞ ǎǘǊłƴƪȅ ǇƻƳƻŎƝ ƳȅǑƛΦ 

±ȊƻǊƻǾŞ ǎǘǊłƴƪȅ όaŀǎǘŜǊ tŀƎŜǎύ ς tƻǳȌƝǾłƴƝ ǾȊƻǊƻǾȇŎƘ ǎǘǊłƴŜƪ !{tΦb9¢Σ ƪǘŜǊŞ Ƨǎƻǳ ȊǇǊŀŎƻǾłƴy na 

ǎŜǊǾŜǊǳΣ ǇƻƳłƘł ǳŘǊȌŜǘ ǎǇǊłǾƴȇ ǾȊƘƭŜŘ ǿŜōƻǾȇŎƘ ǎǘǊłƴŜƪΣ ǳǊȅŎƘƭƛǘ ǇǊƻŎŜǎ ƴłǾǊƘǳ ŀ ȊƧŜŘƴƻŘǳǑƛǘ 

ȊƳŠƴȅ ŎŜƭȇŎƘ ǎǘǊłƴŜƪΦ 5Ɲƪȅ ǾƴƻǌŜƴȇƳ ǾȊƻǊƻǾȇƳ ǎǘǊłƴƪłƳ ǎŜ ƴŜȊǘǊŀǘƝǘŜ ŀƴƛ ǾŜ ǎǇƭŜǘƛǘȇŎƘ 

designech. 

hǾƭłŘŀŎƝ ǇǊǾƪȅ !{tΦb9¢ ς tǌƝǎǘǳǇ ƪ ƻǾƭłŘŀŎƝƳ ǇǊǾƪǻƳ !{tΦb9¢ ŀ ƧŜƧƛŎƘ ǾƭŀǎǘƴƻǎǘŜƳ ƧŜ ǎǘŜƧƴŠ 

ŜŦŜƪǘƛǾƴƝ Ƨŀƪƻ Ȋ aƛŎǊƻǎƻŦǘϯ ±ƛǎǳŀƭ {ǘǳŘƛƻϯ нллрΣ ŀƭŜ ǇǌƛǘƻƳ ƧŜ ǾƛŘƝǘŜ ǇǌƝƳƻ Ǿ ȊƻōǊŀȊŜƴƝ ƴłǾǊƘǳΦ 
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ASP.NET Development Server ς {ǘǊłƴƪȅ !{tΦb9¢ ǎƛ ƳǻȌŜǘŜ ǇǊƻƘƭƝȌŜǘ ƛ ƭƻƪłƭƴŠΣ ŀƴƛȌ ōȅ ōȅƭ ƴǳǘƴȇ 

ƪƻƳǇƭŜǘƴƝ ǿŜōƻǾȇ ǎŜǊǾŜǊΦ 

¿łŘƴŞ ǇǊƻƎǊŀƳƻǾłƴƝ ǾŀȊōȅ ƴŀ Řŀǘŀ ς Y !{tΦb9¢ ǇǌƛǎǘǳǇǳƧŜǘŜ ǇǌŜǎ ǳȌƛǾŀǘŜƭǎƪŞ ǊƻȊƘǊŀƴƝ ƻǾƭłŘŀƴŞ 

ƳȅǑƝΦ Y ǾƛȊǳłƭƴƝƳǳ ǎǾłȊłƴƝ ŘŀǘƻǾȇŎƘ ȊŘǊƻƧǻ ǎ ƻǾƭłŘŀŎƝƳƛ ǇǊǾƪȅ ƴŀ ǇǊŀŎƻǾƴƝ ǇƭƻǑŜ ƴŜƴƝ ƴǳǘƴŞ ȌłŘƴŞ 

ǇǊƻƎǊŀƳƻǾłƴƝΦ 



10  PǊǻǾƻŘŎŜ ǇǊƻŘǳƪǘŜƳ 

(ÌÁÖÎþÃÈ ςπ ÄĳÖÏÄĳȟ ÐÒÏé ÓÉ ËÏÕÐÉÔ 
Expression Web 

ρȢ 5ĿÉÖÁÔÅÌÓËï ÒÏÚÈÒÁÎþ ÐÒÏ ÐÒÏÆÅÓÉÏÎÜÌÎþ ÄÅÓÉÇÎ 

.ǳŘƻǾłƴƝ ƳƻŘŜǊƴƝŎƘ ǿŜōƻǾȇŎƘ ǎǘǊłƴŜƪ ǾȅȌŀŘǳƧŜ ǇǊƻƎǊŀƳΣ Ǿ ƴŠƳȌ Ƨǎƻǳ ƴłǎǘǊƻƧŜΣ ƪǘŜǊŞ 

ǇƻǘǌŜōǳƧŜǘŜΣ ǘŀƳΣ ƪŘŜ ƧŜ ǇƻǘǌŜōǳƧŜǘŜΦ YŘȅȌ Ƨǎƻǳ ǾǑŜŎƘƴŀ ǇƻŘƻƪƴŀ ǵƭƻƘ ŀ ƴŀōƝŘƪȅ ōŠȌƴȇŎƘ őƛƴƴƻǎǘƝ 

ǎǘǊŀǘŜƎƛŎƪȅ ǊƻȊƳƝǎǘŠƴȅ ƴŀ ƴŜƧǾƘƻŘƴŠƧǑƝ ǇƻȊƛŎŜΣ ƳǻȌŜǘŜ ǎŜ ǾƝŎŜ ǾŠƴƻǾŀǘ ǾƭŀǎǘƴƝƳǳ ǇǊƻŎŜǎǳ ƴłǾǊƘǳΣ 

ǇǊƻǘƻȌŜ Ǿłǎ ƴŜȊŘǊȌǳƧŜ ƴłǊƻőƴŞ ǇǊƻƘƭŜŘłǾłƴƝ ƪƻƳǇƭŜȄƴƝŎƘ ǎǘǊǳƪǘǳǊ ƴŀōƝŘŜƪΦ 

ςȢ .ÜÖÒÈ ÓÔÒÜÎÅË ÎÁ ÚÜËÌÁÄñ ÓÔÁÎÄÁÒÄĳ 

9ȄǇǊŜǎǎƛƻƴ ²Ŝō ǾȅǘǾłǌƝ ǎǘǊłƴƪȅ Ǿ ǎƻǳƭŀŘǳ ǎ ƳƻŘŜǊƴƝƳƛ ǎǘŀƴŘŀǊŘȅΣ Ƨŀƪƻ Ƨǎƻǳ ·I¢a[Σ /{{Σ XML a 

·{[¢Φ tǌƝƴƻǎȅ ǇǊƻ ǿŜōƻǾŞƘƻ ŘŜǎƛƎƴŞǊŀ Ƨǎƻǳ ŘŀƭŜƪƻǎłƘƭŞΣ ƻŘ ƭŜǇǑƝƘƻ ȊǇǊŀŎƻǾłƴƝ Ǿ ǊǻȊƴȇŎƘ 

ǇǊƻƘƭƝȌŜőƝŎƘ ŀȌ Ǉƻ ǊŜƭŜǾŀƴǘƴŠƧǑƝ ƛƴŘŜȄƻǾłƴƝ ǾŜ ǾȅƘƭŜŘłǾŀŎƝŎƘ ǇǊƻƎǊŀƳŜŎƘΦ 5ŠƭłǘŜ-ƭƛ ǾŠŎƛ ǎǇǊłǾƴŠ 

ƻŘ ǎŀƳŞƘƻ ǇƻőłǘƪǳΣ ǇƻƳǻȌŜ ǾłƳ ǘƻ ȊǾȇǑƛǘ ǇǊƻŘǳƪǘƛǾƛǘǳΦ 

σȢ +ÁÓËÜÄÏÖï ÓÔÙÌÙ ɉ#33Ɋ Á ĤÁÂÌÏÎÙ ÓÔÒÜÎÅË 

.ƭŜǎƪƻǾȇ ǎǘŀǊǘ ǾłƳ ǳƳƻȌƴƝ ǌŀŘŀ ǇǊƻŦŜǎƛƻƴłƭƴŠ ƴŀǾǊȌŜƴȇŎƘ Ǒŀōƭƻƴ ǇƭƴŠ ǾȅƘƻǾǳƧƝŎƝŎƘ ǎǘŀƴŘŀǊŘǻƳΣ 

z ǑƛǊƻƪŞ ǇƭŜƧłŘȅ ƪŀǘŜƎƻǊƛƝΦ bŜōƻ ƳǻȌŜǘŜ ȊŀőƝǘ ƴłǾǊƘŜƳ /{{ ǇƻŘƭŜ ƴŠƪǘŜǊŞƘƻ Ȋ ǊƻȊƳŀƴƛǘȇŎƘ 

ǊƻȊǾǊȌŜƴƝ ǎǘǊłƴƪȅ όƭŀȅƻǳǘύ ȊŀƭƻȌŜƴȇŎƘ ƴŀ 5L±Φ 

τȢ 2ÏÚÖÒĿÅÎþ ÐÏÍÏÃþ ËÁÓËÜÄÏÖĻÃÈ ÓÔÙÌĳ 

{ƻǳőŀǎƴȇ ȊǇǻǎƻō ǾȅǘǾłǌŜƴƝ ǎǘǊłƴŜƪ ǇƻƳƻŎƝ 

ƪŀǎƪłŘƻǾȇŎƘ ǎǘȅƭǻ Ƴł Ȋŀ ŎƝƭ ƻŘŘŠƭƛǘ ƴłǾǊƘ ǾȊƘƭŜŘǳ 

ƻŘ ƻōǎŀƘǳΦ 9ȄǇǊŜǎǎƛƻƴ ²Ŝō ȊǇǌƝǎǘǳǇƶǳƧŜ ǘǳǘƻ 

ǎƭƻȌƛǘƻǳ ǘŜŎƘƴƻƭƻƎƛƛ ǎǾȇƳƛ ƴłǎǘǊƻƧƛ ǳǊőŜƴȇƳƛ ǇǊƻ 

ŘŜǎƛƎƴΦ ¦ȌƛǾŀǘŜƭ Ƴł Ǉƭƴƻǳ ƪƻƴǘǊƻƭǳ ƴŀŘ ǘƝƳΣ Ƨŀƪ 

ōǳŘŜ ǎǘǊłƴƪŀ ǾȅǇŀŘŀǘΣ ƻŘ ƴŀǎǘŀǾƻǾłƴƝ ƻƪǊŀƧǻ 

a ǾȇǇƭƴƝ ǇƻƳƻŎƝ ƳȅǑƛ Ǉƻ ǾƛȊǳłƭƴƝ ǇƻǳȌƛǘƝ ǎǘȅƭǻΦ 

υȢ 0ÏÕĿÉÔþ ËÁÓËÜÄÏÖĻÃÈ ÓÔÙÌĳ 

aǻȌŜǘŜ ǎƛ ǾȅōǊŀǘ ƳŜȊƛ ŀǳǘƻƳŀǘƛŎƪȇƳ ƎŜƴŜǊƻǾłƴƝƳ /{{ ƴŜōƻ ƧŜƧƛŎƘ ǊǳőƴƝƳ ƻǾƭłŘłƴƝƳΣ ƪǘŜǊŞ 

ŘƻǾƻƭǳƧŜ ƧŜƳƴŞ ŘƻƭŀŘŠƴƝ ǘȅǇǳ ǾȅǘǾłǌŜƴŞƘƻ ǇǊŀǾƛŘƭŀ ŀ ƧŜƘƻ ǇǌŜǎƴŞ ǳƳƝǎǘŠƴƝ ς Ǿƻƭōŀ ƧŜ ƴŀ ǾłǎΦ 

φȢ 3ÐÒÜÖÁ ËÁÓËÜÄÏÖĻÃÈ ÓÔÙÌĳ 

9ȄǇǊŜǎǎƛƻƴ ²Ŝō ǇƻǎƪȅǘǳƧŜ ǇǊǾƻǘǌƝŘƴƝ ǎŀŘǳ ƴłǎǘǊƻƧǻ ǇǊƻ ǎǇǊłǾǳ /{{Φ aǻȌŜǘŜ ǳǊőƛǘΣ ƪŘŜ ǎŜ ōǳŘƻǳ 

ǇǊŀǾƛŘƭŀ /{{ ǾȅǘǾłǌŜǘΣ ƪŘŜ ōǳŘƻǳ ǳƳƝǎǘŠƴŀ ŀ Ǿ ƧŀƪŞƳ ǇƻǌŀŘƝ ǎŜ ōǳŘƻǳ ŀǇƭƛƪƻǾŀǘΣ ŀ ǘƻ ǾǑŜŎƘƴƻ 

ǾƛȊǳłƭƴƝƳƛ ǇǊƻǎǘǌŜŘƪȅΣ ōŜȊ Ȋƴŀƭƻǎǘƛ ƪƽŘǳ ς ǘŜƴ ǾȊƴƛƪł ƴŀ ǇƻȊŀŘƝΦ {ǇǊłǾŀ ƪƻƳǇƭŜȄƴƝŎƘ ƪŀǎƪłŘƻǾȇŎƘ 

ǎǘȅƭǻ ƴƛƪŘȅ ƴŜōȅƭŀ ƧŜŘƴƻŘǳǑǑƝΦ 

χȢ 0ÏÄÏËÎÏ ÖÌÁÓÔÎÏÓÔþ 

tƻŘƻƪƴŀ ǾƭŀǎǘƴƻǎǘƝ ȊŀƧƛǑǙǳƧƝ ǊȅŎƘƭȇ ǇǌƝǎǘǳǇ ƪŜ ƪƻƳǇƭŜǘƴƝ ǑƪłƭŜ ǾƭŀǎǘƴƻǎǘƝ /{{ ŀ ȊƴŀőŜƪΦ Seznam si 

ƳǻȌŜǘŜ ǳǎǇƻǌłŘŀǘ ǘŀƪΣ ŀōȅǎǘŜ ǎƴŀŘƴƻ ƴŀǑƭƛ ǘȅΣ ƪǘŜǊŞ ǇƻǘǌŜōǳƧŜǘŜΣ ŀ ŀōȅ ǎŜ ȊƻōǊŀȊƛƭȅ ƧŜƴ ǘȅ 

Ǿƭŀǎǘƴƻǎǘƛ /{{Σ ƪǘŜǊŞ Ƨǎƻǳ ǇǊłǾŠ ǇƻǳȌƛǘȅΦ 
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ψȢ 6ÙËÒÅÓÌÏÖÜÎþ ÓÔÒÜÎÅË 

tǌŜǎƴŞ ȊƻōǊŀȊŜƴƝ ǎǘǊłƴƪȅ 

v ƴłǾǊƘłǌ-ǎƪŞƳ ǇǊƻǎǘǌŜŘƝ 

ƧŜ ǇǊƻ ŘŜǎƛƎƴŞǊŀ ȊłǎŀŘƴƝ 

ǇƻŘƳƝƴƪƻǳΦ ±ŠǌƝƳŜΣ ȌŜ 

ƧłŘǊƻ 9ȄǇǊŜǎǎƛƻƴ ²Ŝōǳ ǇƻǎƪȅǘǳƧŜ ƴŜƧǇǌŜǎƴŠƧǑƝ ǾȅƪǊŜǎƭŜƴƝΣ ƧŀƪŞ ƧŜ ŘƴŜǎ ŘƻǎǘǳǇƴŞΦ ± ȊłǾƛǎƭƻǎǘƛ ƴŀ 

ǇƻǳȌƛǘŞƳ ǘȅǇǳ ŘƻƪǳƳŜƴǘǳ όŘƻŎǘȅǇŜύ ǇǌŜǇƝƴł ȊƻōǊŀȊŜƴƝ ƳŜȊƛ ǎǘŀƴŘŀǊŘƴƝƳ ŀ ƴŜǎǘŀƴŘŀǊŘƴƝƳΦ 

aǻȌŜǘŜ se spolehnout ƴŀ ǘƻΣ ȌŜ ǎǘǊłƴƪȅ ōǳŘƻǳ Ǿ ǇǊƻƘƭƝȌŜőƛ ǾȅǇŀŘŀǘ ǎǘŜƧƴŠ Ƨŀƪƻ ōŠƘŜƳ ƴłǾǊƘǳΦ 

ωȢ 6ĻÓÔÉĿÎÜ ÐÒÅÚÅÎÔÁÃÅ ÄÁÔ 

±ƛȊǳłƭƴƝ ǇǊłŎŜ ǎ Řŀǘȅ ǾŜ ŦƻǊƳłǘǳ ·a[ ƧŜ ǾŜƭƳƛ ƧŜŘƴƻŘǳŎƘłΦ {ǘŀőƝ ǎƻǳōƻǊ ·a[ ǇǌŜǘłƘƴƻǳǘ ƳȅǑƝ ŀ ƧŜ 

ƛƘƴŜŘ ƛƴǘŜǊǇǊŜǘƻǾłƴ Ǒŀōƭƻƴƻǳ ό·{[ ǎǘȅƭŜǎƘŜŜǘύΣ ƪǘŜǊƻǳ ƳǻȌŜǘŜ ǇǌŜŦƻǊƳłǘƻǾŀǘ ǘŀƪΣ ŀōȅ ƻŘǇƻǾƝŘŀƭŀ 

stylu vaǑƛŎƘ ǎǘǊłƴŜƪΦ aǻȌŜǘŜ ǎƴŀŘƴƻ ƴŀőƝǘŀǘΣ ŦƛƭǘǊƻǾŀǘ ŀ ǌŀŘƛǘ Řŀǘŀ Ȋ ƭƛōƻǾƻƭƴŞƘƻ ȊŘǊƻƧŜ ·a[Φ 

10. ASP.NET 2.0 

±ŀǑŜ ǎǘǊłƴƪȅ ōǳŘƻǳ Ƨŀƪƻ ȌƛǾŞ ς ǇƻǎƭŜŘƴƝ ǾŜǊȊŜ !{tΦb9¢ ƴŀōƝȊƝ ƻǾƭłŘŀŎƝ ǇǊǾƪȅ ǇǊƻ ǊƻȊƳŀƴƛǘŞ ǵőŜƭȅΣ 

ƻŘ ƴŀǾƛƎŀŎŜ ǇǌŜǎ ƪŀƭŜƴŘłǌŜ ŀ ǇǌƛƘƭŀǑƻǾłƴƝ ŀȌ Ǉƻ ǇǊłŎƛ ǎ ŘŀǘŀōłȊŜƳƛΦ ¢ƻ ǾǑŜ ƧŜ ǾłƳ ƪ ŘƛǎǇƻȊƛŎƛ ƴŀ 

ǇǊŀŎƻǾƴƝ ǇƭƻǑŜΣ ŀƴƛȌ ōȅǎǘŜ ōȅƭƛ ƴǳŎŜƴƛ ǇǊƻƎǊŀƳƻǾŀǘΦ 

ρρȢ .ÁÂþÄËÁ #ÏÎÔÒÏÌ #ÏÍÍÏÎ 4ÁÓËÓ 

¢ȅǘƻ ƴŀōƝŘƪȅ ǎƭƻǳȌƝ ǇǊƻ ǊȅŎƘƭȇ ǇǌƝǎǘǳǇ ƪ ƴŜƧōŠȌƴŠƧǑƝƳ ǵƪƻƭǻƳ ǘȇƪŀƧƝŎƝƳ ǎŜ ƪƻƴŦƛƎǳǊŀŎŜ ƻǾƭłŘŀŎƝŎƘ 

ǇǊǾƪǻΣ ƻŘ ǌŀȊŜƴƝ ŀ ŦƛƭǘǊƻǾłƴƝ Řŀǘ Ǉƻ ƴŀǎǘŀǾƻǾłƴƝ ǾȊƘƭŜŘǳ ŀ ŎƘƻǾłƴƝ ƻǾƭłŘŀŎƝŎƘ ǇǊǾƪǻΦ 

ρςȢ 6ÚÏÒÏÖï ÓÔÒÜÎËÙ ɉ-ÁÓÔÅÒ 0ÁÇÅÓɊ 

Chcete-li zachovat 

ƪƻƴȊƛǎǘŜƴǘƴƝ ŘŜǎƛƎƴ Ǿ ǊłƳŎƛ 

ŎŜƭŞƘƻ ǿŜōǳ όǿŜōǎƛǘŜύΣ 

ȊŀƭƻȌǘŜ ƴłǾǊƘ ǎǘǊłƴƪȅ ƴŀ 

ǾȊƻǊƻǾŞ ǎǘǊłƴŎŜΣ ƪǘŜǊł ƧŜ 

ȊǇǊŀŎƻǾłƴŀ Ǉǌƛ ƪŀȌŘŞƳ 

ǇƻȌŀŘŀǾƪǳ ƴŀ ǎǘǊłƴƪǳ 

ǇǊƻǎǘǌŜŘƴƛŎǘǾƝƳ ŀǇƭƛƪŀőƴƝƘƻ 

ǎŜǊǾŜǊǳΦ ±ȊƻǊƻǾŞ ǎǘǊłƴƪȅ ƭȊŜ 

ǾƴƻǌƻǾŀǘ ŀ ǾȅǘǾłǌŜǘ ǘŀƪ 

ǎƭƻȌƛǘŠƧǑƝ ƘƛŜǊŀǊŎƘƛŜΦ 

13. IntelliSense  

YŘȅȌ ŘƻƧŘŜ ƴŀ ŜŘƛǘƻǾłƴƝ ƪƽŘǳ ǎǘǊłƴƪȅΣ ǳǇƭŀǘƴƝ ǎŜ LƴǘŜƭƭƛ{ŜƴǎŜ ǎ ŦǳƴƪŎŜƳƛ ǇǊƻ ŘƻƪƻƴőƻǾłƴƝ ƪƽŘǳ ς 

ōŠƘŜƳ ǇǎŀƴƝ ǇƻǎǘǳǇƴŠ ȊǇǌŜǎƶǳƧŜ ƴŀōƝȊŜƴŞ ƳƻȌƴƻǎǘƛ Ǿ ȊłǾƛǎƭƻǎǘƛ ƴŀ ǘȅǇǳ ŘƻƪǳƳŜƴǘǳ ŀ ǾŜǊȊƛ /{{Φ 

ρτȢ (ÙÐÅÒÔÅØÔÏÖï ÏÄËÁÚÙ ÐÒÏ ÓÔÙÌÙ 

±ȅƘƭŜŘŀǘ ȊŘǊƻƧ ǇƻǳȌƛǘŞƘƻ ǎǘȅƭǳ ƴŜƴƝ ǘŠȌƪŞΣ /ǘǊƭ Ҍ ƪƭŜǇƴǳǘƝ ƳȅǑƛ ƴŀ ƭƛōƻǾƻƭƴŞ ƛŘ ƴŜōƻ ƴłȊŜǾ ǘǌƝŘȅ 

v ȊƻōǊŀȊŜƴŞƳ ƪƽŘǳ Ǿłǎ ǇǌŜƴŜǎŜ ǇǌƝƳƻ ƴŀ ƻŘǇƻǾƝŘŀƧƝŎƝ ǇǊŀǾƛŘƭƻΦ 

ρυȢ ªÔÒĿËÙ ËĕÄÕ 

hōƭƝōŜƴŞ őłǎǘƛ ƪƽŘǳ ƳǻȌŜǘŜ ǇƻǳȌƝǾŀǘ ƻǇŀƪƻǾŀƴŠΣ ǎǘŀőƝ ƧŜ ǳƭƻȌƛǘ Ƨŀƪƻ ǵǘǊȌƪȅ ƪƽŘǳ ŀ ǇƻǘƻƳ ƧŜ 

ƴŠƪƻƭƛƪŀ ǵƘƻȊȅ Řƻ ƪƭłǾŜǎƴƛŎŜ ǎƴŀŘƴƻ ŀ ǊȅŎƘƭŜ ŘƻǎǘŀƴŜǘŜ ǘŀƳΣ ƪŀƳ ǇƻǘǌŜōǳƧŜǘŜΦ 
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16. ASP.NET Development Server 

{ǘǊłƴƪȅ !{tΦb9¢ ǎƛ ƳǻȌŜǘŜ ǇǊƻƘƭƝȌŜǘ 

ƴŀ ǇǊŀŎƻǾƴƝ ǎǘŀƴƛŎƛΣ ŀƴƛȌ ōȅ ōȅƭ 

ƴǳǘƴȇ ƪƻƳǇƭŜȄƴƝ ǿŜōƻǾȇ ǎŜǊǾŜǊΦ 

YŘȅȌ ƧŜ ȊŀǇƻǘǌŜōƝ ƻōǎƭƻǳȌƛǘ ǎǘǊłƴƪȅ 

!{tΦb9¢Σ ǎǇǳǎǘƝ ǎŜ !{tΦb9¢ 5ŜǾŜƭƻǇƳŜƴǘ {ŜǊǾŜǊΣ ǘŀƪȌŜ ǎŜ ȊōȅǘŜőƴŠ ƴŜǇƭȇǘǾł ǎȅǎǘŞƳƻǾȇƳƛ 

ǇǊƻǎǘǌŜŘƪȅ ǇƻǘǌŜōƴȇƳƛ ǇǊƻ ōŠƘ ǇƭƴŞƘƻ ǿŜōƻǾŞƘƻ ǎŜǊǾŜǊǳΦ 

ρχȢ 0ĠÅÈÌÅÄÙ 

±ȅőŜǊǇłǾŀƧƝŎƝ ǇǌŜƘƭŜŘȅ ǘȇƪŀƧƝŎƝ ǎŜ ǑƛǊƻƪŞ ǇŀƭŜǘȅ ǘŜŎƘƴƻƭƻƎƛƝ ǇƻǎƪȅǘǳƧƝ ȊłǊǳƪǳΣ ȌŜ Ǿ implemen-

ǘƻǾŀƴȇŎƘ ǎǘǊłƴƪłŎƘ ƴŜƧǎƻǳ ŎƘȅōȅΦ YƻƴǘǊƻƭǳƧŜ ǎŜ ǇƻǳȌƛǘƝ ƪŀǎƪłŘƻǾȇŎƘ ǎǘȅƭǻ ŀ ƧŜƧƛŎƘ ŎƘȅōȅΣ 

ǇǌƝǎǘǳǇƴƻǎǘ ǇƻŘƭŜ {ŜŎǘƛƻƴ рлу ŀ ²/!D ŀ ƪƻƳǇŀǘƛōƛƭƛǘŀ ǎ ŀƭǘŜǊƴŀǘƛǾƴƝƳƛ ǎŎƘŞƳŀǘȅ ŀ ǇǊƻƘƭƝȌŜőƛΦ 

18. Integrace s produktem Visual Studio  

{ǘǊłƴƪȅ ǾȅǘǾƻǌŜƴŞ ǇƻƳƻŎƝ 9ȄǇǊŜǎǎƛƻƴ ²Ŝōǳ Ƨǎƻǳ ǇƭƴŠ ƪƻƳǇŀǘƛōƛƭƴƝ ǎ ǇǊƻŘǳƪǘŜƳ ±ƛǎǳŀƭ {ǘǳŘƛƻΦ 

5ŀƭǑƝ őƭŜƴƻǾŞ ǇǊŀŎƻǾƴƝƘƻ ǘȇƳǳ ǘŜŘȅ ƳƻƘƻǳ ǇƻƪǊŀőƻǾŀǘ Ǿ ǇǊƻƎǊŀƳƻǾłƴƝ Ŧǳƴƪőƴƻǎǘƛ !{tΦb9¢ 

ǎǘǊłƴŜƪΣ ƪǘŜǊŞ ƧǎǘŜ ƴŀǾǊƘƭƛΦ 

19. Optimalizace HTML  

tǌƛ ƴŀǎŀȊƻǾłƴƝ ƘƻǘƻǾȇŎƘ ǎǘǊłƴŜƪ ƴŀ ǿŜōƻǾȇ ǎŜǊǾŜǊ ǾȅǳȌƛƧǘŜ ǾȇƪƻƴƴŞ ŦǳƴƪŎŜ ǇǊƻ ƻŘǎǘǊŀƴŠƴƝ 

ƪƻƳŜƴǘłǌǻ ŀ ǇǊłȊŘƴȇŎƘ ƳƝǎǘΦ ¢ƝƳ ȊŀƧƛǎǘƝǘŜ Ŏƻ ƴŜƧǾȅǑǑƝ ǊȅŎƘƭƻǎǘ ǎǘŀƘƻǾłƴƝ ŀ ƻōǎƭǳƘƻǾłƴƝ ǎƻǳōƻǊǻ ƴŀ 

ǎŜǊǾŜǊǳΣ ǇǌƛőŜƳȌ ǾŀǑŜ ƭƻƪłƭƴƝ ƪƻǇƛŜ Ȋǻǎǘŀƴƻǳ ƴŜŘƻǘőŜƴȅΦ 

ςπȢ 2ÏÚĤÉĠÉÔÅÌÎÏÓÔ 

tǻǾƻŘƴƝ Ŧǳƴƪőƴƻǎǘ 9ȄǇǊŜǎǎƛƻƴ ²Ŝōǳ ƭȊŜ ǊƻȊǑƛǌƻǾŀǘ ǇƻƳƻŎƝ ŘƻǇƭƶƪǻ Ȋ ǇǊƻŘǳƪŎŜ aƛŎǊƻǎƻŦǘǳ ƴŜōƻ 

ƧƛƴȇŎƘ ŦƛǊŜƳΣ ǇǌƝǇŀŘƴŠ ǎƛ ƧŜ ƳǻȌŜǘŜ ǾȅǘǾłǌŜǘ ǎŀƳƛ ǎ ǾȅǳȌƛǘƝƳ {5YΦ 
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0ÒÏÃÖÉéÔÅ ÓÉ ÒÕÃÅ 

/ ÔïÔÏ ÓÅËÃÉ 
{ƻǳőłǎǘƝ ŘƻŘłǾƪȅ 9ȄǇǊŜǎǎƛƻƴ ²Ŝōǳ ƧŜ ǇǌƝǊǳőƪŀ vǳƛŎƪ {ǘŀǊǘ DǳƛŘŜ ǾŜ ŦƻǊƳłǘǳ t5C ŀ ŘǾƻǳƘƻŘƛƴƻǾŞ 

ǾȇǳƪƻǾŞ ǾƛŘŜƻ ǎ ƴłǾƻŘŜƳΣ Ƨŀƪ ȊŀőƝǘΦ ±ƝƳŜ ƻǾǑŜƳΣ ȌŜ ƴŜ ƪŀȌŘȇ ǊŜŎŜƴȊŜƴǘ Ƴł Řƻǎǘ őŀǎǳΣ ŀōȅ ǇǊƻǑŜƭ 

ŎŜƭƻǳ αǳőŜōƴƛŎƛά ƪ ǇǊƻŘǳƪǘǳΣ ƪǘŜǊȇ ǇƻǎǳȊǳƧŜΣ ǇǊƻǘƻ Ƨŀƪƻ ŀƭǘŜǊƴŀǘƛǾǳ ƪ ǘŠƳǘƻ ȊŘǊƻƧǻƳ ƴŀōƝȊƝƳŜ 

ƴŠƪƻƭƛƪ ƧŜŘƴƻŘǳŎƘȇŎƘ ŎǾƛőŜƴƝΣ ǳƳƻȌƶǳƧƝŎƝŎƘ ǊȅŎƘƭŜƧƛ ǇǊƻƴƛƪƴƻǳǘ Řƻ ǾƭŀǎǘƴƻǎǘƝ ǇǊƻŘǳƪǘǳΦ ¢ŠŎƘǘƻ 

dvacet ŎǾƛőŜƴƝ ƻŘǇƻǾƝŘł ƘƭŀǾƴƝƳ dvaceti ǊȅǎǻƳ ǇƻǇǎŀƴȇƳ ǾȇǑŜΣ ŀƭŜ ƧŜƧƛŎƘ ǇƻǌŀŘƝ ǎŜ ǇƻƴŠƪǳŘ ƭƛǑƝΣ 

ŀōȅ ƴŀ ǎŜōŜ ƧŜŘƴƻǘƭƛǾł ŎǾƛőŜƴƝ ƭŞǇŜ ƴŀǾŀȊƻǾŀƭŀΦ 5ƻǇƻǊǳőǳƧŜƳŜ ǾłƳ ǾǑŀƪΣ ŀōȅǎǘŜ ǎƛ ƪ ǘŠƳǘƻ 

ŎǾƛőŜƴƝƳ ǇǌƛōǊŀƭƛ ǇǌƝǊǳőƪǳ vǳƛŎƪ {ǘŀǊǘ DǳƛŘŜΦ 

ρȢ 5ĿÉÖÁÔÅÌÓËï ÒÏÚÈÒÁÎþ ÐÒÏ ÐÒÏÆÅÓÉÏÎÜÌÎþ ÄÅÓÉÇÎ 

Á bŀƛƴǎǘŀƭǳƧǘŜ ŀ ǎǇǳǎǙǘŜ 9ȄǇǊŜǎǎƛƻƴ ²ŜōΦ 

Á LƳǇƭƛŎƛǘƴŠ ƧŜ ǾŜ őǘȅǌŜŎƘ ƻƪƴŜŎƘ ȊƻōǊŀȊŜƴƻ ǑŜǎǘ ƴŜƧǇƻǳȌƝǾŀƴŠƧǑƝŎƘ ǇƻŘƻƪŜƴ ǵƭƻƘΥ 

o CƻƭŘŜǊ ƭƛǎǘ όǎŜȊƴŀƳ ǎƭƻȌŜƪύ 

o Properties (vlastnosti) 

Á ¢ŀƎ tǊƻǇŜǊǘƛŜǎ όǾƭŀǎǘƴƻǎǘƛ Ȋƴŀőƪȅύ 

Á CSS Properties (vlastnosti CSS) 

o ¢ƻƻƭōƻȄ όǇŀƴŜƭ ƴłǎǘǊƻƧǻύ 

o CSS 

Á Apply CSS (poǳȌƛǘƝ /{{ύ 

Á aŀƴŀƎŜ /{{ όǎǇǊłǾŀ /{{ύ 

Á tƻŘƻƪƴŀ ƳǻȌŜǘŜ ǊƻȊƳƝǎǘƛǘ Ǉƻ ǳȌƛǾŀǘŜƭǎƪŞƳ ǊƻȊƘǊŀƴƝ ǇƻƳƻŎƝ ƳȅǑƛΦ 

Á ½ ƴŀōƝŘƪȅ ¢ŀǎƪǇŀƴŜ ƳǻȌŜǘŜ ƻǘŜǾǌƝǘ ŘŀƭǑƝ ǇƻŘƻƪƴŀΦ 

Á !ƪǘǳłƭƴƝ ǾȊƘƭŜŘ ƻƪŜƴ ǎŜ ȊŀǇŀƳŀǘǳƧŜΦ 

Á ±ǊŀǙǘŜ ǇƻŘƻƪƴŀ Řƻ ǇǻǾƻŘƴƝƘƻ ǎǘŀǾǳ Ǿƻƭōƻǳ Task Panes > Reset Workspace Layout . 

Á YŘȅȌ ƧŜ ƻǘŜǾǌŜƴŀ ƴŠƧŀƪł ǎǘǊłƴƪŀΣ ƳłǘŜ ƴŀ ǾȇōŠǊ ƳŜȊƛ ȊƻōǊŀȊŜƴƝƳ ƴłǾǊƘǳ ό5ŜǎƛƎƴ ǾƛŜǿύΣ 

ȊƻōǊŀȊŜƴƝƳ ƪƽŘǳ ό/ƻŘŜ ǾƛŜǿύ ƴŜōƻ ǊƻȊŘŠƭŜƴȇƳ ȊƻōǊŀȊŜƴƝƳ ό{Ǉƭƛǘ ǾƛŜǿύΣ ƪǘŜǊŞ ƧŜ ƧŜƧƛŎƘ 

ƪƻƳōƛƴŀŎƝΦ 

ςȢ .ÜÖÒÈ ÓÔÒÜÎÅË ÎÁ ÚÜËÌÁÄñ ÓÔÁÎÄÁÒÄĳ 

Á ¦ȌƛǾŀǘŜƭ ƳǻȌŜ ǊǻȊƴȇƳƛ ȊǇǻǎƻōȅ ŘŜŦƛƴƻǾŀǘΣ Ƨŀƪ ŎƘŎŜ ǇǊŀŎƻǾŀǘ Ǿ 9ȄǇǊŜǎǎƛƻƴ ²ŜōǳΦ bŀǇǌŜŘ 

ǎŜ ƳǳǎƝ ǊƻȊƘƻŘƴƻǳǘΣ ƪǘŜǊŞ ǵǊƻǾƴŠ ǎǘŀƴŘŀǊŘǳ ǎŜ ōǳŘŜ ŘǊȌŜǘΦ ¢ƻ ƻǾƭƛǾƴƝ ǾǑŜŎƘƴȅ ƴƻǾŞ 

ǎǘǊłƴƪȅΣ ƪǘŜǊŞ ōǳŘŜ ǾȅǘǾłǌŜǘ ǵǇƭƴŠ ƻŘ ȊŀőłǘƪǳΦ ±ǑŜŎƘƴȅ ǇǌŜŘŜƳ ǇǌƛǇǊŀǾŜƴŞ Ǒŀōƭƻƴȅ 

ǇƻǳȌƝǾŀƧƝ ·I¢a[ мΦл ¢Ǌŀƴǎƛǘƛƻƴŀƭ ŀ /{{ нΦмΦ 
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Á Vyberte 4ÏÏÌÓ ˲ 0ÁÇÅ %ÄÉÔÏÒ /ÐÔÉÏÎÓƛ ŀ Ǉŀƪ ȊłƭƻȌƪǳ Authoring . 

 
Á 5ƻƭƴƝ ǇƻƭƻǾƛƴŀ ǳǊőǳƧŜ ǘȅǇ ŘƻƪǳƳŜƴǘǳΣ ƪǘŜǊȇ ǎŜ ōǳŘŜ ǇƻǳȌƝǾŀǘΦ tǌŜŘǾƻƭŜƴł ƘƻŘƴƻǘŀ ƧŜ 

XHTML 1.0 Transitional. 

Á {ŜŎƻƴŘŀǊȅ {ŎƘŜƳŀ ǎŜ ǳǇƭŀǘƴƝ ǳ ǇǌŜǾȊŀǘȇŎƘ ǎǘǊłƴŜƪΣ ƪǘŜǊŞ ƴŜƳŀƧƝ Ȋƴŀőƪǳ ŘƻŎǘȅǇŜ ƴŜōƻ ƧŜ 

ƴŜǇƭŀǘƴłΦ ¢ƝƳ ƳǻȌŜǘŜ ǇǌƛƳŠǘ ŦǳƴƪŎƛ ƻƘƭŀǑƻǾłƴƝ ŎƘȅō ŀ LƴǘŜƭƭƛǎŜƴǎŜ Ǿ ȊƻōǊŀȊŜƴƝ ƪƽŘǳΣ ŀōȅ 

ǇǊŀŎƻǾŀƭȅ ǇƻŘƭŜ ǾłƳƛ ȊǾƻƭŜƴŞƘƻ ǎǘŀƴŘŀǊŘu. 

Á ¦ƪƻƴőŜǘŜ ŘƛŀƭƻƎ ǘƭŀőƝǘƪŜƳ Cancel . 

σȢ +ÁÓËÜÄÏÖï ÓÔÙÌÙ ɉ#33Ɋ Á ĤÁÂÌÏÎÙ ÓÔÒÜÎÅË 

Á bŜǎƳƝ ōȇǘ ƻǘŜǾǌŜƴ ȌłŘƴȇ ǿŜō ς vyberte File > Close Site , je-ƭƛ ǘŀǘƻ Ǿƻƭōŀ ǇǌƝǎǘǳǇƴłΦ 

Á bƻǾƻǳ ǎǘǊłƴƪǳ ǾȅǘǾƻǌƝǘŜ Ǿƻƭōƻǳ &ÉÌÅ ˲ .Å×ƛ ˲ 0ÁÇÅƛ 

Á tǊƻȊƪƻǳƳŜƧǘŜ ǾǑŜŎƘƴȅ ƳƻȌƴƻǎǘƛ ŘƛŀƭƻƎƻǾŞƘƻ ƻƪƴŀ ǇǊƻ ƧŜŘƴƻǘƭƛǾƻǳ ǎǘǊłƴƪǳΣ ȊŜƧƳŞƴŀ 

ǊƻȊǾǊȌŜƴƝ ǇƻƳƻŎƝ ƪŀǎƪłŘƻǾȇŎƘ ǎǘȅƭǻ ό/{{ ƭŀȅƻǳǘǎύΦ 

Á bȅƴƝ ǇǌŜƧŘŠǘŜ ƴŀ ȊłƭƻȌƪǳ ²Ŝō {ƛǘŜ Ǿ ƘƻǊƴƝ őłǎǘƛ ŘƛŀƭƻƎǳΦ 

Á ½ǾƻƭǘŜ ǇƻŘǎŜƪŎƛ ¢ŜƳǇƭŀǘŜǎ όǑŀōƭƻƴȅύ ŀ ǇƻŘƝǾŜƧǘŜ ǎŜΣ ƧŀƪŞ ǊƻȊƳŀƴƛǘŞ Ǒŀōƭƻƴȅ Ƨǎƻǳ 

k ŘƛǎǇƻȊƛŎƛΦ ±ǑŜŎƘƴȅ Ƨǎƻǳ ǾȅǘǾƻǌŜƴȅ ǇƻƳƻŎƝ 5ȅƴŀƳƛŎ ²Ŝō ¢ŜƳǇƭŀǘŜǎΣ ǘŀƪȌŜ ƴŜƧǎƻǳ ȊłǾƛǎƭŞ 

na ASP.NET. 
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Á ±ȅǘǾƻǌǘŜ ǿŜō ȊŀƭƻȌŜƴȇ ƴŀ ǑŀōƭƻƴŠ Small Business 1: vyberte ji v seznamu a zadejte 

ǳƳƝǎǘŠƴƝ ƴŀ ǇŜǾƴŞƳ ŘƛǎƪǳΣ ƪŀƳ ǎŜ Ƴł ǿŜō ǳƭƻȌƛǘΦ 

 
Á ± ǎŜȊƴŀƳǳ ǎƭƻȌŜƪ ƧŜ ǘŜř ǾƛŘŠǘ ƪƻƳǇƭŜǘƴŠ ǇǌƛǇǊŀǾŜƴȇ ǿŜōΣ ƪǘŜǊȇ ǎƛ ǳȌƛǾŀǘŜƭ ƳǻȌŜ ǳǇǊŀǾƛǘ 

ǇƻŘƭŜ ǎǾȇŎƘ ǇƻǘǌŜō ȊƳŠƴƻǳ ƎǊŀŦƛŎƪȇŎƘ ǇǊǾƪǻΣ ōŀǊŜǾ ŀ ǇǌŜŘǾƻƭŜƴŞƘƻ ǘŜȄǘǳΦ 

Á hǘŜǾǌŜǘŜ Ǿ ǎŜȊƴŀƳǳ ǎƭƻȌŜƪ ǎƻǳōƻǊ ǎ ǑŀōƭƻƴƻǳΣ ǇƻƧƳŜƴƻǾŀƴȇ master.dwt . 

Á ¢ƻǘƻ ƧŜ ŘƻƪǳƳŜƴǘΣ Ȋ ƴŠƘƻȌ ǎŜ ōǳŘƻǳ ǾȅǘǾłǌŜǘ ǾǑŜŎƘƴȅ ǎǘǊłƴƪȅ ǘƻƘƻǘƻ ǿŜōǳΦ 

Á ½ƳŠƶǘŜ ƴŠƪǘŜǊŞ Ȋ ǘŜƭŜŦƻƴƴƝŎƘ őƝǎŜƭ Ǿ ǇǊŀǾŞƳ ƘƻǊƴƝƳ ǊƻƘǳ ƴŀ ƴŠƧŀƪŞ ƧƛƴŞΣ ƴŀǇǌƝƪƭŀŘ όрррύ 

ррр ррррΦ WŀƪƳƛƭŜ ǇǊƻǾŜŘŜǘŜ ȊƳŠƴǳΣ ƻōƧŜǾƝ ǎŜ ƴŀ ȊłƭƻȌŎŜ ǾŜŘƭŜ ƴłȊǾǳ ǎƻǳōƻǊǳ ƘǾŠȊŘƛőƪŀ 

ǎƛƎƴŀƭƛȊǳƧƝŎƝΣ ȌŜ ōȅƭ ǎƻǳōƻǊ ȊƳŠƴŠƴΦ 

Á Zvolte File > Save Φ ±ȅǎƪƻőƝ ǳǇƻȊƻǊƴŠƴƝΣ ȌŜ ǎ ǘƻǳǘƻ Ǒŀōƭƻƴƻǳ ƧŜ ǎǇƻƧŜƴƻ мр ǎƻǳōƻǊǻΦ 

Volbou Yes ǎŜ ƧƛŎƘ ǾǑŜŎƘ мр ȊŀƪǘǳŀƭƛȊǳƧŜΦ 

τȢ 6ÙËÒÅÓÌÏÖÜÎþ ÓÔÒÜÎÅË 

Á 9ȄǇǊŜǎǎƛƻƴ ²Ŝō Ƴł Ǿ ȊƻōǊŀȊŜƴƝ ƴłǾǊƘǳ dva ǊŜȌƛƳȅ ǾȅƪǊŜǎƭƻǾłƴƝΥ ǾŜƭƳƛ ƪǾŀƭƛǘƴƝ ǊŜȌƛƳ ƴŀ 

ȊłƪƭŀŘŠ ǎǘŀƴŘŀǊŘǻ ŀ ƴŜǎǘŀƴŘŀǊŘƴƝΣ ƪƻƳǇŀǘƛōƛƭƴƝ ǊŜȌƛƳ αvǳƛǊƪǎά ȊŀƭƻȌŜƴȇ ƴŀ L9р ǇǊƻ 

ǾȅƪǊŜǎƭƻǾłƴƝ ǎǘŀǊǑƝŎƘ ǎǘǊłƴŜƪΦ {ǘŀƴŘŀǊŘƴƝ ǊŜȌƛƳ ƴŜǾȅŎƘłȊƝ Ȋ ȌłŘƴŞƘƻ ƛƴǎǘŀƭƻǾŀƴŞƘƻ 

ǇǊƻƘƭƝȌŜőŜΣ ƧŜ ǘƻ ƴŜȊłǾƛǎƭł ǘŜŎƘƴƻƭƻƎƛŜ ǾŜǎǘŀǾŠƴł Řƻ ǇǊƻƎǊŀƳǳΦ Y ǇǊƻǎǘǳŘƻǾłƴƝ ǘŠŎƘǘƻ 

dvou ǊŜȌƛƳǻ ƧŜ ƴǳǘƴŞ ƴŜƧǇǊǾŜ ƻǘŜǾǌƝǘ ŘƻƳƻǾǎƪƻǳ ǎǘǊłƴƪǳ default.htm . 

Á ±ǑƛƳƴŠǘŜ ǎƛ ŘǾƻǳ ǾŠŎƝΦ ½ŀ ǇǊǾŞΣ ƘƻǊƴƝ őłǎǘ ŘƻƪǳƳŜƴǘǳ ƧŜ ǳȊŀƳőŜƴŀ ς ƧŜ ƴŀ ƴƝ ǎȅƳōƻƭ 

ƻȊƴŀőǳƧƝŎƝ ƻōƭŀǎǘƛΣ ƪǘŜǊŞ Ǒŀōƭƻƴŀ ǳȊŀƳƪƭŀΦ ½ŀ ŘǊǳƘŞΣ Ǿ ŘƻƪǳƳŜƴǘǳ ƧŜ ȊƻōǊŀȊŜƴƻ ȊƳŠƴŠƴŞ 

ǘŜƭŜŦƻƴƴƝ őƝǎƭƻΦ 
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Á {ǘŀǾƻǾȇ ǌłŘŜƪ ǳƪŀȊǳƧŜ ǎǘŀƴŘŀǊŘƴƝ ǊŜȌƛƳΣ ǇƻǳȌƛǘȇ ǘȅǇ ŘƻƪǳƳŜƴǘǳ ŀ ǾŜǊȊƛ CSS. 

 
 

Á tƻǌłŘƴŠ ǎƛ ǇǊƻƘƭŞŘƴŠǘŜ ǾȊƘƭŜŘ ǎǘǊłƴƪȅ ŀ Ǉŀƪ ǎƛ Ǿ ŘƻƭƴƝ őłǎǘƛ ŘƻƪǳƳŜƴǘǳ ǾȅōŜǊǘŜ ȊƻōǊŀȊŜƴƝ 

ƪƽŘǳ ό/ƻŘŜ ǾƛŜǿύΦ 

Á ½ǾȇǊŀȊƴŠǘŜ ǇǊǾƴƝ ǌłŘŜƪ ƪƽŘǳΣ ȊŀőƝƴŀƧƝŎƝ <! DOCTYPEé>Σ ŀ ǎƳŀȌǘŜ ƘƻΦ bƻǾȇ ǇǊǾƴƝ ǌłŘŜƪ ǘŜř 

ȊŀőƝƴł <html é>. 

Á tǌŜǇƴŠǘŜ ȊǇŠǘ Řƻ ȊƻōǊŀȊŜƴƝ ƴłǾǊƘǳ ό5ŜǎƛƎƴ ǾƛŜǿύΦ {ǘǊłƴƪŀ ōȅ ǘŜř ƳŠƭŀ ǾȅǇŀŘŀǘ ǘǊƻŎƘǳ 

Ƨƛƴŀƪ ŀ Ƨŀƪ ƧŜ ǾƛŘŠǘ ǾŜ ǎǘŀǾƻǾŞƳ ǌłŘƪǳΣ ǊŜȌƛƳ ǎŜ ȊƳŠƴƛƭ ƴŀ ƴŜǎǘŀƴŘŀǊŘƴƝ όvǳƛǊƪǎύ 

a ǳǇƭŀǘƴƛƭƻ ǎŜ ǎŜƪǳƴŘłǊƴƝ ǎŎƘŞƳŀ ǇǊƻƘƭƝȌŜőŜ L9сΦ 

 
 

Á ¢ƝƳ ƧǎƳŜ ȊƝǎƪŀƭƛ ǇǌƝƭŜȌƛǘƻǎǘ ǇƻŘƝǾŀǘ ǎŜΣ Ƨŀƪ ǎŜ 9ȄǇǊŜǎǎƛƻƴ ²Ŝō ǾȅǇƻǌłŘł ǎ ŎƘȅōŀƳƛΣ ǇǊƻǘƻȌŜ 

ǘǳ ƳłƳŜ ƴŀǇǊƻǎǘƻ ǎǇǊłǾƴȇ ŘƻƪǳƳŜƴǘ ·I¢a[Σ ŀǾǑŀƪ ōŜȊ ǇƻǾƛƴƴŞ Ȋƴŀőƪȅ doctype . 

tǌŜǇƴŠǘŜ ȊǇŠǘ Řƻ ȊƻōǊŀȊŜƴƝ ƪƽŘǳ ŀ ǾǑƛƳƴŠǘŜ ǎƛ ƳƝǎǘΣ ƪǘŜǊł Ƨǎƻǳ őŜǊǾŜƴŠ ǇƻŘǘǊȌŜƴŀΦ YŘȅȌ 

ƴŀŘ ƭƛōƻǾƻƭƴȇƳ Ȋ ƴƛŎƘ ǇƻŘǊȌƝǘŜ ƴŀ ŎƘǾƝƭƛ ǳƪŀȊŀǘŜƭ ƳȅǑƛΣ ƻōƧŜǾƝ ǎŜ ǾȅǎǾŠǘƭƛǾƪŀΣ ƻ jakou chybu 

ƧŘŜΣ ŀ őŀǎǘƻ ƛ ƴłǾƻŘΣ Ƨŀƪ Ƨƛ ƻǇǊŀǾƛǘΦ 

 

υȢ ªÔÒĿËÙ ËĕÄÕ 

Á Chcete-ƭƛ ƻǇǊŀǾƛǘ ǇƻǑƪƻȊŜƴȇ ǘȅǇ ŘƻƪǳƳŜƴǘǳΣ ƴŀǎǘŀǾǘŜ ƪǳǊȊƻǊ ǇǌŜŘ ǇǊǾƴƝ Ȋƴŀƪ ƴŀ ǇǊǾƴƝƳ 

ǌłŘƪǳΦ YƭłǾŜǎŀƳƛ Ctrl-Enter ǾȅǾƻƭłǘŜ ǎŜȊƴŀƳ ǵǘǊȌƪǻ ƪƽŘǳΣ Ǿ ƴŠƳȌ ǎŜ ƳǻȌŜǘŜ ǇƻƘȅōƻǾŀǘ 

ǇƻƳƻŎƝ ƪƭłǾŜǎ ǎŜ ǑƛǇƪŀƳƛΦ tƻǎǳƶǘŜ ǎŜ ƴŀ ǇƻƭƻȌƪǳ XHTML 1.0 Transitional DOCTYPE  

a ƪƭłǾŜǎƻǳ 9ƴǘŜǊ Ƨƛ ǾƭƻȌǘŜ Řƻ ŘƻƪǳƳŜƴǘǳΦ 

 
Á 5ŀƭǑƝ ǵǘǊȌƪȅ ƭȊŜ ǾƪƭłŘŀǘ Ǿƻƭōƻǳ 4ÏÏÌÓ ˲ 0ÁÇÅ %ÄÉÔÏÒ /ÐÔÉÏÎÓƛ ŀ ȊŘŜ ǇǌŜŎƘƻŘŜƳ ƴŀ 

ȊłƭƻȌƪǳ Page Snippets . 
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błǎƭŜŘǳƧƝŎƝ ǎŜƪŎŜ ǎŜ ǾŠƴǳƧŜ ǘŜŎƘƴƻƭƻƎƛƛ ƪŀǎƪłŘƻǾȇŎƘ ǎǘȅƭǻ (Cascading Style Sheet, CSS) 

a ȊǇǻǎƻōǻƳΣ Ƨŀƪ ǎ ƴƛƳƛ ȊŀŎƘłȊŜǘΦ ½ŀǾǌŜƳŜ ǇǌŜŘŎƘƻȊƝ ǿŜō ŀ ȊŀőƴŜƳŜ ǎ ƴƻǾȇƳ ȊŀƭƻȌŜƴȇƳ ƴŀ 

ǾȊƻǊƻǾŞ ǎǘǊłƴŎŜ !{tΦb9¢Φ 

φȢ 6ÚÏÒÏÖï ÓÔÒÜÎËÙ ɉ-ÁÓÔÅÒ 0ÁÇÅÓɊ 

Á ½ŀǾǌŜǘŜ ŜȄƛǎǘǳƧƝŎƝ ǿŜō Ǿƻƭōƻǳ File > Close Site ŀ ƳǻȌŜǘŜ Ƙƻ ƛ ƻŘǎǘǊŀƴƛǘ Ȋ ǇŜǾƴŞƘƻ 

Řƛǎƪǳ ǇƻƳƻŎƝ tǊǻȊƪǳƳƴƝƪŀΦ 

Á ±ȅǘǾƻǌǘŜ ƴƻǾȇ ǿŜō Ǿƻƭōƻǳ &ÉÌÅ ˲ .Å×ƛ ˲ 7ÅÂ 3ÉÔÅƛ 

Á ± őłǎǘƛ General  vyberte Empty Web Site Σ ȊŀŘŜƧǘŜ ǳƳƝǎǘŠƴƝ ƴƻǾŞƘƻ ǿŜōǳ ŀ ƴłȊŜǾ 

ReviewCSS ŀ ƪƭŜǇƴŠǘŜ ƴŀ OK. 

Á bȅƴƝ ƳłǘŜ ǇǊłȊŘƴȇ ȊŘǊƻƧ ǇǊƻ ǾȅǘǾƻǌŜƴƝ ǾȊƻǊƻǾŞ ǎǘǊłƴƪȅ !{tΦb9¢Φ 

Á tƻƪǊŀőǳƧǘŜ Ǿƻƭōƻǳ &ÉÌÅ ˲ .Å×ƛ ˲ 0ÁÇÅƛ ŀ Ǿ őłǎǘƛ ASP.NET vyberte Master Page . 

ό±ǑƛƳƴŠǘŜ ǎƛΣ ȌŜ ǾǇǊŀǾƻ ŘƻƭŜ ǎŜ Řł ǾȅōǊŀǘ ƧŀȊȅƪ ǇǊƻ ƪƽŘ ǾȊƴƛƪŀƧƝŎƝ ƴŀ ǇƻȊŀŘƝΦύ YƭŜǇƴŠǘŜ ƴŀ 

OK. 

Á {ǘǊłƴƪǳ ƘƴŜŘ ǳƭƻȌǘŜ Ƨŀƪƻ Site.master . 

Á bŀ ǎǘǊłƴŎŜ ƧŜ ƻōƭŀǎǘ ǇƻƧƳŜƴƻǾŀƴł CƻǊƳмΦ YƭŜǇƴŠǘŜ Řƻ ƴƝ ŀ ȊƧƛǎǘƝǘŜΣ ȌŜ ƧǎǘŜ ǾŜ ǎǇŜŎƛłƭƴƝ 

ƻōƭŀǎǘƛΣ ƪǘŜǊŞ ǎŜ ǌƝƪł /ƻƴǘŜƴǘtƭŀŎŜIƻƭŘŜǊΦ YŀȌŘł ǎǘǊłƴƪŀ ƻŘǾƻȊŜƴł Ȋ ŘŀƴŞƘƻ ǾȊƻǊǳ ƳǻȌŜ 

ƳƝǘ Ǿ ǘŞǘƻ ƻōƭŀǎǘƛ ǎǾǻƧ ǾƭŀǎǘƴƝ ƻōǎŀƘΦ bŀǾǊƘƴŜǘŜ ǘŜŘȅ ǾȊƘƭŜŘ ŀ ŎƘƻǾłƴƝ ǎǘǊłƴƪȅ ŀ ǳǊőƝǘŜΣ 

ƪǘŜǊŞ ƧŜƧƝ őłǎǘƛ ōǳŘƻǳ /ƻƴǘŜƴǘtƭŀŎŜIƻƭŘery, tj. Ȋǻǎǘŀƴƻǳ αƻŘŜƳőŜƴŞά ǇǊƻ ŜŘƛǘƻǾłƴƝΦ 

χȢ 2ÏÚÖÒĿÅÎþ ÐÏÍÏÃþ ËÁÓËÜÄÏÖĻÃÈ ÓÔÙÌĳ 

Á aƻŘŜǊƴƝ ǎǘǊłƴƪȅΣ ƪǘŜǊŞ ǎŜ ŘǊȌƝ ŘƻǇƻǊǳőŜƴŞƘƻ ǇƻƧŜǘƝ ƴłǾǊƘǳ ǾȊƘƭŜŘǳ ƻŘŘŠƭŜƴŞƘƻ ƻŘ 

ƻōǎŀƘǳΣ Ƨǎƻǳ ƴŀǾǊƘƻǾłƴȅ ŀ ōǳŘƻǾłƴȅ ǎ ǾȅǳȌƛǘƝƳ /{{Σ ȊƴŀőŜƪ div  a vrstev div  (to jsou 

Ȋƴŀőƪȅ div  ǎ ŀōǎƻƭǳǘƴƝƳ ǇƻȊƛŎƻǾłƴƝƳύΣ ŎƻȌ ƧŜ ȊƳŠƴŀ ƻǇǊƻǘƛ ŘǌƝǾŠƧǑƝƳǳ ōŠȌƴŞƳǳ ȊǾȅƪǳ 

ǇƻǳȌƝǾŀǘ ǘŀōǳƭƪȅΦ 

Á ½ƴŀőƪȅ div  ǎŜ ŘŀƧƝ ǾȅǘǾłǌŜǘ ǊǻȊƴȇƳƛ ȊǇǻǎƻōȅΥ ƴŀǇǎŀǘ ƧŜ ǇǌƝƳƻ Řƻ ƪƽŘǳΣ ǇǌƛŘŀǘ ƧŜ Ȋ ǇŀƴŜƭǳ 

ƴłǎǘǊƻƧǻ ό¢ƻƻƭōƻȄύ ƴŜōƻ ǇƻǳȌƝǘ ǇƻŘƻƪƴƻ ǵƭƻƘ [ŀȅŜǊǎ ǇǊƻ ǾȅǘǾƻǌŜƴƝ ǾǊǎǘǾȅΦ tǊƻǘƻȌŜ ƧŜ 

ŘǻƭŜȌƛǘŞΣ ƪŘŜ Ƨǎƻǳ ǘȅǘƻ ǇǊǾƪȅ Ǿ ƘƛŜǊŀǊŎƘƛƛ ȊƴŀőŜƪ ǳƳƝǎǘŠƴȅΣ ƧŜ ǾƘƻŘƴŞ ǇǊŀŎƻǾŀǘ ǎŜ 

ȊłƪƭŀŘƴƝƳƛ ǇǊǾƪȅ Ǿ ǊƻȊŘŠƭŜƴŞƳ ȊƻōǊŀȊŜƴƝ ό{Ǉƭƛǘ ǾƛŜǿύΦ ¢ƝƳ ƧŜ ȊŀǊǳőŜƴƻΣ ȌŜ ƧŜ ǇǊǾŜƪ 

ǳƳƝǎǘŠƴ ǇǌŜǎƴŠ ǘŀƳΣ ƪŘŜ Ƙƻ ŎƘŎŜǘŜΦ 

Á ± ŘƻƭƴƝ őłǎǘƛ ǎǘǊłƴƪȅ ȊǾƻƭǘŜ Split . 

Á tǌŜŘ ƛƳǇƭƛŎƛǘƴƝ /ƻƴǘŜƴǘtƭŀŎŜIƻƭŘŜǊ ŎƘŎŜƳŜ ǳƳƝǎǘƛǘ div Σ ƪǘŜǊȇ ōǳŘŜ ƻōǎŀƘƻǾŀǘ ȊłƘƭŀǾƝ 

ǎǘǊłƴƪȅΦ bŀǎǘŀǾǘŜ ǘŜŘȅ ƪǳǊȊƻǊ Ǿ ƪƽŘǳ ǇǌŜŘ ǘŜƴǘƻ ǇǊǾŜƪ ŀ Ǉŀƪ ǇƻƪƭŜǇŜƧǘŜ Ǿ ǇŀƴŜƭǳ ƴłǎǘǊƻƧǻ 

na <div >. 

Á tǌŜƧŘŠǘŜ Ȋ ƪƽŘǳ Řƻ ƴłǾǊƘǳ ŀ ƪƭŜǇƴǳǘƝƳ ǇǊłǾŠ ǾȅǘǾƻǌŜƴƻǳ Ȋƴŀőƪǳ div  ŀƪǘƛǾǳƧǘŜ όƪƭŜǇƴŠǘŜ 

ƴŀ ƳŜȊŜǊǳ ƴŀŘ ŜȄƛǎǘǳƧƝŎƝƳ /ƻƴǘŜƴǘtƭŀŎŜIƻƭŘŜǊŜƳύΦ ±ȇǎƭŜŘŜƪ ōȅ ƳŠƭ ǾȅǇŀŘŀǘ ǘŀƪǘƻΥ 

 



18  PǊǻǾƻŘŎŜ ǇǊƻŘǳƪǘŜƳ 

Á WŜ ǾƘƻŘƴŞΣ ŀōȅ ƳŠƭ ƪŀȌŘȇ div  ƴŀ ǎǘǊłƴŎŜ ƧŜŘƛƴŜőƴŞ id Σ ǇǊƻǘƻ Ǿ ǇƻŘƻƪƴŠ Tag Properties 

όǾƭŜǾƻ ŘƻƭŜύ ƴŀǇƛǑǘŜ Řƻ ǇƻƭŜ id  PageHeader . 

 
Á Velikost Ȋƴŀőƪȅ div  ƭȊŜ ǳǇǊŀǾƛǘ ǇƻŘƭŜ ǇƻǘǌŜōȅ ƻǾƭŀŘŀőŜƳ Ǿ ƧŜƘƻ ǇǊŀǾŞƳ ŘƻƭƴƝƳ ǊƻƘǳΦ 

½ƳŠƶǘŜ Ƨƛ ƴŀ ǇǌƛōƭƛȌƴŠ слл ǇƛȄŜƭǻ ƴŀ ǑƝǌƪǳ ŀ нлл ǇƛȄŜƭǻ ƴŀ ǾȇǑƪǳΦ tǌŜǎƴŞ ǊƻȊƳŠǊȅ Ǿ ǘƻƳǘƻ 

ǇǌƝǇŀŘŠ ƴŜƘǊŀƧƝ ǊƻƭƛΦ 

 

ψȢ 0ÏÕĿÉÔþ ËÁÓËÜÄÏÖĻÃÈ ÓÔÙÌĳ 

Á YŘȅȌ ǎŜ ȊŀǎŜ ǇƻŘƝǾłǘŜ ƴŀ ƪƽŘΣ ǳǾƛŘƝǘŜΣ ȌŜ ǎŜ ȊƳŠƴŀ velikosti Ȋƴŀőƪȅ div  ǇǊƻƳƝǘƭŀ Řƻ 

ǾƭƻȌŜƴŞƘƻ ǎǘȅƭǳ όƛƴƭƛƴŜ ǎǘȅƭŜύΥ 
<div id="PageHeader" style="width: 600px; height: 200px">  

Á 9ȄǇǊŜǎǎƛƻƴ ²Ŝō ǇǊłǾŠ ōŠȌƝ Ǿ ǊŜȌƛƳǳΣ ƪŘȅ ǎ ƪŀǎƪłŘƻǾȇƳƛ ǎǘȅƭȅ ǇǊŀŎǳƧŜ ƴŀ ȊłƪƭŀŘŠ ǎŀŘȅ 

ǾŜǎǘŀǾŠƴȇŎƘ ǇǊŀǾƛŘŜƭΦ ¢ŀǘƻ ǇǊŀǾƛŘƭŀ ǎŜ ŘŀƧƝ ȊƻōǊazit volbou Tools > Page Editor 

Options  ŀ ǇǌŜǇƴǳǘƝƳ ƴŀ ȊłƭƻȌƪǳ CSS. 
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Á ±ǑƛƳƴŠǘŜ ǎƛΣ ȌŜ Ǿ ǌłŘƪǳ Sizing, positioning and floating  je nastaveno CSS (inline 

ǎǘȅƭŜǎύΣ ǘŜŘȅ ǾƭƻȌŜƴŞ ǎǘȅƭȅΦ aǻȌŜǘŜ ǘƻ ȊƳŠƴƛǘ ƴŀ ǘǌƝŘȅ όŎƭŀǎǎŜǎύΣ ǇƻƪǳŘ ŎƘŎŜǘŜΦ 

 
Á Chcete-ƭƛ ƳƝǘ Ǉƭƴƻǳ ƪƻƴǘǊƻƭǳ ƴŀŘ ƪŀȌŘȇƳ ƧŜŘƴƻǘƭƛǾȇƳ ǊƻȊƘƻŘƴǳǘƝƳΣ ƪǘŜǊŞ ǇǊƻƎǊŀƳ ǳŘŠƭłΣ 

ǇǌŜǇƴŠǘŜ ǇƻǳȌƝǾłƴƝ ǎǘȅƭǻ Řƻ ƳŀƴǳłƭƴƝƘƻ ǊŜȌƛƳǳΦ ± ŘƛŀƭƻƎǳ ǾȅōŜǊǘŜ Manual Style 

Application ŀ ƪƭŜǇƴŠǘŜ ƴŀ OK. 

Á hōƧŜǾƝ ǎŜ ƴƻǾȇ ǇŀƴŜƭ ƴłǎǘǊƻƧǻ Style Application Σ ƪǘŜǊȇ ƳǻȌŜǘŜ ƴŀǇŜǾƴƻ ǳƳƝǎǘƛǘ ƪ 

ƘƻǊƴƝƳǳ ƻƪǊŀƧƛ ƻōǊŀȊƻǾƪȅ ǇƻŘ ǇŀƴŜƭ ƴłǎǘǊƻƧǻ /ƻƳƳƻƴΦ 

Á ± ǘƻƳǘƻ ǊŜȌƛƳǳ ƳǻȌŜǘŜ ǾȇōŠǊŜƳ ŎƝƭƻǾŞƘƻ ǇǊŀǾƛŘƭŀ ό¢ŀǊƎŜǘ wǳƭŜύ ǎǘŀƴƻǾƛǘΣ ƪŘŜ ǎŜ ƳŀƧƝ 

ƴƻǾŞ ǎǘȅƭȅ ǾȅǘǾłǌŜǘΦ 

Á ¢ƭŀőƝǘƪŜƳ Reuse Property  ƴŀ ǇŀƴŜƭǳ ƴłǎǘǊƻƧǻ ǳǊőƝǘŜΣ ȌŜ Ƴł 9ȄǇǊŜǎǎƛƻƴ ²Ŝō ǾȅƘƭŜŘłǾŀǘ 

Ǿƭŀǎǘƴƻǎǘƛ Ǿ ƪŀǎƪłŘŠ ǇǊŀǾƛŘŜƭ ǎƳŠǊŜƳ ǾȊƘǻǊǳΦ ¢ƻ ǎƛ ȌłŘł ǇƻŘǊƻōƴŠƧǑƝ ǾȅǎǾŠǘƭŜƴƝΦ ½ƳŠƴƝǘŜ-li 

ǾȊƘƭŜŘ ǇƝǎƳŀ Ǿ ƻȊƴŀőŜƴŞƳ ƻŘǎǘŀǾŎƛ ŀ Řŀƴȇ ǾȊƘƭŜŘ ǇƝǎƳŀ ƧŜ ǾŜ ǎƪǳǘŜőƴƻǎǘƛ ƴŀǎǘŀǾŜƴ 

ǇǊŀǾƛŘƭŜƳ ǾȊǘŀƘǳƧƝŎƝƳ ǎŜ ƪe ȊƴŀőŎŜ div Σ ƧŜȌ ǘŜƴǘƻ ƻŘǎǘŀǾŜŎ ƻōǎŀƘǳƧŜΣ ȊŀǎǘŀǾƝ ŦǳƴƪŎŜ 

Reuse Property  ǾȅǘǾłǌŜƴƝ ƴƻǾŞƘƻ ǇǊŀǾƛŘƭŀ ŀ ƳƝǎǘƻ ǘƻƘƻ ǇǊƻǾŜŘŜ ȊƳŠƴǳ ǾŜ ǘǌƝŘŠ ǎǇƧŀǘŞ 

s Řŀƴƻǳ Ȋƴŀőƪƻǳ div . 

ωȢ 3ÐÒÜÖÁ ËÁÓËÜÄÏÖĻÃÈ ÓÔÙÌĳ 

Á ±ȅǘǾƻǌƝƳŜ ƴŠƧŀƪȇ ǘŜȄǘ ŀ ǎǘȅƭȅΣ ŀōȅŎƘƻƳ ǎƛ ǳƪłȊŀƭƛΣ Ƨŀƪ ǎƴŀŘƴƻ ƭȊŜ ǇƻƳƻŎƝ 9ȄǇǊŜǎǎƛƻƴ ²Ŝōǳ 

ǎǇǊŀǾƻǾŀǘ ǎƭƻȌƛǘŞ ƘƛŜǊŀǊŎƘƛŜ ǇǊŀǾƛŘŜƭΦ 

Á Nastavte kurzor do Ȋƴŀőƪȅ div , kterou ƧǎǘŜ ǾȅǘǾƻǌƛƭƛΣ ŀ ƴŀǇƛǑǘŜ ŘǾŀ ǌłŘƪȅ ǘŜȄǘǳΥ 
Company Name 
Company Location  

Á tǊƻ ƻȊƴŀőŜƴȇ ǘŜȄǘ ƳǻȌŜǘŜ ǾȅōǊŀǘ ǇƻȌŀŘƻǾŀƴƻǳ Ȋƴŀőƪǳ Ȋ ǇŀƴŜƭǳ ƴłǎǘǊƻƧǻ /ƻƳƳƻƴΦ 



20  PǊǻǾƻŘŎŜ ǇǊƻŘǳƪǘŜƳ 

Á YƭŜǇƴŠǘŜ ƴŀ ǇǊǾƴƝ ǌłŘŜƪ ŀ Ǿ ǎŜȊƴŀƳǳ ǇǊƻ ƴŠƧ ǾȅōŜǊǘŜ Ȋƴŀőƪǳ h1. 

 
Á YƭŜǇƴŠǘŜ ƴŀ ŘǊǳƘȇ ǌłŘŜƪ ŀ ǎǘŜƧƴȇƳ ȊǇǻǎƻōŜƳ ǇǊƻ ƴŠƧ ǾȅōŜǊǘŜ Ȋƴŀőƪǳ h2. 

Á 5ŜƧƳŜ ǘƻƳǳΣ ȌŜ ǾŜǑƪŜǊȇ ǘŜȄǘ ƴŀ ǎǘǊłƴŎŜ Ƴł ƳƝǘ ǇƝǎƳƻ ±ŜǊŘŀƴŀΦ {ǇǊłǾƴŠ ǎŜ ǘƻ ǳŘŠƭł ǘŀƪΣ 

ȌŜ ǎŜ ǾȅǘǾƻǌƝ ǇǊŀǾƛŘƭƻ ǇǌƛǌŀȊŜƴŞ ƪ ǇǊǾƪǳ ōƻŘȅ όǘŠƭƻύΦ YƭŜǇƴŠǘŜ ƴŀ ǘƭŀőƝǘƪƻ .Å× 3ÔÙÌÅƛ 

v ǇǊŀǾŞƳ ŘƻƭƴƝm rohu podokna Apply Style .  

Á ¢Ŝƴǘƻ ŘƛŀƭƻƎ ǳƳƻȌƶǳƧŜ ǾȅǘǾłǌŜǘ ƴŜōƻ ŜŘƛǘƻǾŀǘ ǾǑŜŎƘƴȅ Ǿƭŀǎǘƴƻǎǘƛ ǇǊŀǾƛŘƭŀ ƴŀ ƧŜŘƴƻƳ 

ƳƝǎǘŠΦ 5ƻǇǌŜƧǘŜ ǎƛ ŎƘǾƝƭƛ őŀǎǳ ŀ ǇǊƻǎǘǳŘǳƧǘŜ ǾǑŜŎƘƴȅ ƪŀǘŜƎƻǊƛŜΦ 

Á ½ ƴŀōƝŘƪȅ {ŜƭŜŎǘƻǊ ǾǇǊŀǾƻ ƴŀƘƻǌŜ ǾȅōŜǊǘŜ bodyΦ 5łƭŜ Ȋ ƪŀǘŜƎƻǊƛŜ Ŧƻƴǘ ǾȅōŜǊǘŜ ǊƻŘinu 

ǇƝǎŜƳ Verdana  όǾȇōŠǊ ƳǻȌŜǘŜ ǳǊȅŎƘƭƛǘΣ ƪŘȅȌ Řƻ ǇƻƭŜ ƴŀǇƝǑŜǘŜ ǇƝǎƳŜƴƻ vύΦ YƭŜǇƴŠǘŜ ƴŀ OK 

ŀ ƻōŀ ǌłŘƪȅ ǘŜȄǘǳ ǎŜ ȊƳŠƴƝΦ 

Á bȅƴƝ ǾȅǘǾƻǌƝƳŜ ǇǊŀǾƛŘƭƻΣ ƪǘŜǊŞ ǇǊǾƴƝ ǌłŘŜƪ ƻōŀǊǾƝ ƴŀ ƳƻŘǊƻΦ aǻȌŜƳŜ ǾȅǘǾƻǌƛǘ ōǳř ǘǌƝŘǳΣ 

nebo pravidlo pro prvek h1Φ ±ȅōŜǊŜƳŜ ǎƛ ŘǊǳƘƻǳ ƳƻȌnost. 

Á YƭŜǇƴŠǘŜ ȊƴƻǾǳ ƴŀ .Å× 3ÔÙÌÅƛ ǘŀƪ Ƨŀƪƻ ǇǌŜŘǘƝƳΣ Ȋ ƴŀōƝŘƪȅ {ŜƭŜŎǘƻǊ ǾȅōŜǊǘŜ h1  

a ǘŜƴǘƻƪǊłǘ ƴŀǎǘŀǾǘŜ ŎƻƭƻǊ ƴŀ Blue . 

Á ¢Ŝř ōȅŎƘƻƳ ŎƘǘŠƭƛ Ǉƻǎǳƴƻǳǘ ǘŜȄǘ ǘǊƻŎƘǳ ƴƝȌ ƻŘ ƘƻǊƴƝƘƻ ƻƪǊŀƧŜ ŀ ǘǊƻŎƘǳ ŘƻƭŜǾŀ ƻŘ ƭŜǾŞƘƻ 

ƻƪǊŀƧŜΦ aǻȌŜƳŜ ǘƻ ȊŀǌƝŘƛǘ ǇǌƛŘłƴƝƳ ǾȇǇƭƴŠ Řƻ ǇƻƭŜ Ȋƴŀőƪȅ div Φ !ƭŜ ƪŘŜ ǎŜ Ƴł ǘƻǘƻ 

ǇǊŀǾƛŘƭƻ ǇƻǳȌƝǘΚ L ȊŘŜ ǇƭŀǘƝΣ ȌŜ ȌłŘƴł Ȋ ǊǻȊƴȇŎƘ ƳƻȌƴƻǎǘƝ ƴŜƴƝ ǎǇǊłǾƴł ƴŜōƻ ǑǇŀǘƴłΦ 

±ȅǘǾƻǌƳŜ ǇǊŀǾƛŘƭƻΣ ƪǘŜǊŞ ǎŜ Ƴł ŀǇƭƛƪƻǾŀǘ ƴŀ id Σ ƪǘŜǊŞ ƧǎƳŜ ǇǌŜŘǘƝƳ ǇǌƛǌŀŘƛƭƛ ȊƴŀőŎŜ div  

a nazvali jsme ho PageHeader Φ tƻǳȌƛƧŜƳŜ ƴŀ ǘƻ ƴƻǾȇ Ǉƻstup. 
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ρπȢ 6ÉÚÕÜÌÎþ ÏËÒÁÊÅ Á ÖĻÐÌÎñ 

Á bŀǇǌŜŘ ƪƭŜǇƴŠǘŜ ƴŀ ǘŜȄǘ ŀ Ǉŀƪ ƴŀ ǘŜőƪƻǾŀƴȇ ǊłƳŜőŜƪ Ȋƴŀőƪȅ ƪ ƻȊƴŀőŜƴƝ ƻŘǇƻǾƝŘŀƧƝŎƝ 

Ȋƴŀőƪȅ div . 

 
Á !ōȅŎƘƻƳ ǎƛ ōȅƭƛ ƧƛǎǘƛΣ ȌŜ ǾǑŜŎƘƴȅ ȊƳŠƴȅΣ ƪǘŜǊŞ ǳŘŠƭłƳŜΣ ōǳŘƻǳ ŀǇƭƛƪƻǾłƴȅ ƴŀ ǇǊŀǾƛŘƭƻ 

ǾȊǘŀƘǳƧƝŎƝ ǎŜ ƪ id  PageHeader  Ȋƴŀőƪȅ div Σ ǾǊłǘƝƳŜ ǎŜ ƴŀ ǇŀƴŜƭ ƴłǎǘǊƻƧǻ Style 

Application  ŀ Ȋ ƴŀōƝŘƪȅ Target Rule  vybereme .Å× !ÕÔÏ )$ Ƨʢ0ÁÇÅ(ÅÁÄÅÒƨ. 

¢ŀǘƻ ǇƻƭƻȌƪŀ ǎŜ ƴŀōƝȊƝ ǇǊłǾŠ ŘƝƪȅ ǘƻƳǳΣ ȌŜ ƧǎƳŜ ƴŀ ȊƴŀőŎŜΣ ƪǘŜǊŞ ƧǎƳŜ ǇǌƛǌŀŘƛƭƛ id . 

Á ±ǇǊŀǾƻ ƴŀƘƻǌŜ ƴŀ ȊƴŀőŎŜ div  ǎŜ ƻōƧŜǾƛƭŀ ǾƻŘƻǊƻǾƴł ǾƭŀǎƻǾł őłǊŀΦ YŘȅȌ ƴŀ ƴƝ ǇƻŘǊȌƝǘŜ 

ƳȅǑΣ ƳŠƭŀ ōȅ ǎŜ ȊƻōǊŀȊƛǘ ǾȅǎǾŠǘƭƛǾƪŀ margin - top: (15px) . Kdybyste na ni klepli 

a ǇƻǇƻǘłƘƭƛ Ƨƛ ŘƻƭǻΣ ȊǾŠǘǑƛƭ ōȅ ǎŜ ƻƪǊŀƧ ƴŀŘ Ȋƴŀőƪƻǳ div Φ aȅ ŀƭŜ ŎƘŎŜƳŜ ȊǾŠǘǑƛǘ ǾȇǇƭƶ ǳǾƴƛǘǌ 

Ȋƴŀőƪȅ div Φ tǊƻǘƻ ƴŀǇǌŜŘ ǇƻŘǊȌǘŜ ƪƭłǾŜǎǳ Shift ŀ Ǉŀƪ ƪƭŜǇƴŠǘŜ ŀ ǘłƘƴŠǘŜ Řƻƭǻ ς ǘƝƳ ǎŜ 

ȊƳŠƴƝ ǾȇǇƭƶΦ bŀǎǘŀǾǘŜ Ƨƛ ƴŀ 20px . 
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Á ¢ƻǘŞȌ ȊƻǇŀƪǳƧǘŜ ǎ őłǊƻǳ ǾƭŜǾƻ ŘƻƭŜ ŀ ƴŜȊŀǇƻƳŜƶǘŜ ȊŀǎŜ ǇƻŘǊȌŜǘ ƪƭłǾŜǎǳ Shift. 

 !Ȍ ǘƻ ŘƻƪƻƴőƝǘŜΣ ǳǾƛŘƝǘŜΣ ȌŜ ƪŘȅȌ ƧŜ div  ƻȊƴŀőŜƴΣ ƧŜ ƪ ŘƛǎǇƻȊƛŎƛ ōŀǊŜǾƴŞ ǾƛȊǳłƭƴƝ ǊƻȊƭƛǑŜƴƝ 

ǾƴƛǘǌƴƝ ǾȇǇƭƴŠ όƳƻŘǊłύ ƛ ǾƴŠƧǑƝƘƻ ƻƪǊŀƧŜ όǊǻȌƻǾłύΦ ¢ŀǘƻ ǇƻƳǻŎƪŀ ǳǎƴŀŘƶǳƧŜ ŘŜǎƛƎƴŞǊǻƳ 

ǇǌŜǎƴŞ ƻǾƭłŘłƴƝ ǇǊǾƪǻ ƴŀ ǎǘǊłƴŎŜ ŀ ǇƻǎƪȅǘǳƧŜ ƧƛƳ ǇǌŜƘƭŜŘ ƻ ǘƻƳΣ Ƨŀƪ ƻƪǊŀƧŜ ŀ ǾȇǇƭƴŠ 

ƻǾƭƛǾƶǳƧƝ ƧŜƧƛŎƘ ƴłǾǊƘΦ 

Á tłǊ ŘŀƭǑƝŎƘ ȊƳŠƴ /{{ ǘŜř ǇǊƻǾŜŘŜƳŜ ǇǌƝƳƻ Ǿ ƪƽŘǳΦ 

11. IntelliSense  

Á bŠƪŘȅ Ƴł ƛ ǇǊƻ ƴłǾǊƘłǌŜ ǎƳȅǎƭ ǇǊŀŎƻǾŀǘ ǊƻǾƴƻǳ ǎ ƪƽŘŜƳΣ őŀǎǘƻ ƧŜ ǘƻ ǊȅŎƘƭŜƧǑƝ ŀ ǇǌŜǎƴŠƧǑƝΦ 

¢ŜƴǘƻƪǊłǘ ŘǊǳƘŞƳǳ ǌłŘƪǳ ǘŜȄǘǳΣ Company Location Σ ǇǌƛǌŀŘƝƳŜ ǘǌƝŘǳΦ 

Á tǌŜǇƴŠǘŜ Řƻ ȊƻōǊŀȊŜƴƝ ƪƽŘǳ ŀ ƴŀǎǘŀǾǘŜ ƪǳǊȊƻǊ ǘŠǎƴŠ ǇǌŜŘ ƪƻƴŎƻǾƻǳ ƭƻƳŜƴƻǳ ȊłǾƻǊƪǳ > 

Ȋƴŀőƪȅ h2. 

 
Á bŀǇƛǑǘŜ ƳŜȊŜǊǳ ŀ ǾȊłǇŠǘƝ ǾȅǎƪƻőƝ ƴŀōƝŘƪŀ ǘƻƘƻΣ Ŏƻ ōȅǎǘŜ ŀǎƛ ǘŀƪ ƳƻƘƭƛ ŎƘǘƝǘ ƴŀǇǎŀǘΦ /ƘŎŜǘŜ 

ǇǌƛŘŀǘ ŀǘǊƛōǳǘ ǘǌƝŘȅΣ ƴŀǇƛǑǘŜ ǘŜŘȅ ǇƝǎƳŜƴƻ c a ukazatel se v seznamu posune rovnou na 

ŎƭŀǎǎΦ YƭłǾŜǎƻǳ Enter ǎŜ ǘŀǘƻ ǇƻƭƻȌƪŀ ŀǳǘƻƳŀǘƛŎƪȅ ǾƭƻȌƝ Řƻ ƪƽŘǳ ŀ ǇǊƻǘƻȌŜ Ǿƭŀǎǘnost class 

ƳǳǎƝ ƳƝǘ ƧŜǑǘŠ ŀǘǊƛōǳǘ Ǿ ǳǾƻȊƻǾƪłŎƘΣ ŘƻǇƭƴƝ ǎŜ ƛ ǳǾƻȊƻǾƪȅ ŀ ƳŜȊƛ ƴŠ ǎŜ ǳƳƝǎǘƝ ƪǳǊȊƻǊΦ 

bŀǇƛǑǘŜ ƴłȊŜǾ ƴƻǾŞ ǘǌƝŘȅ myRedText . 
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Á tǌŜǇƴŠǘŜ ȊǇŠǘ Řƻ ȊƻōǊŀȊŜƴƝ ƴłǾǊƘǳ ŀ ǇƻŘƝǾŜƧǘŜ ǎŜΣ Ƨŀƪ ǎŜ ǘŀǘƻ ȊƳŠƴŀ ǇǊƻƧŜǾƛƭŀ ƴŀ 

ƻȊƴŀőŜƴŞƳ ǌłŘƪǳ ǘŜȄǘǳ. 

 
Á ±ǊŀǙǘŜ ǎŜ Řƻ ȊƻōǊŀȊŜƴƝ ƪƽŘǳ ŀ ƴŀƧŘŠǘŜ ōƭƻƪ ǎǘȅƭǳΣ ƪǘŜǊȇ 9ȄǇǊŜǎǎƛƻƴ ²Ŝō ǾȅǘǾƻǌƛƭ Ǿ ƘƻǊƴƝ 

őłǎǘƛ ŘƻƪǳƳŜƴǘǳΦ aǳǎƝǘŜ ǘŜř ƴŀǎǘŀǾƛǘ ƪǳǊȊƻǊ Ȋŀ ǇƻǎƭŜŘƴƝ ǇǊŀǾƛŘƭƻ Ǿ ōƭƻƪǳΣ ŎƻȌ ōȅ ƳŠƭƻ ōȇǘ 

id  #PageHeader Σ ǘŠǎƴŠ ǇǌŜŘ Ȋƴŀőƪǳ </ style > ŀ ǇƻǘƻƳ ƪƭłǾŜǎƻǳ Enter ǾƭƻȌƛǘ ǇǊłȊŘƴȇ 

ǌłŘŜƪΦ ¢ŜƴǘƻƪǊłǘ ǾȅǘǾłǌƝƳŜ ǘǌƝŘǳ ŀ ǘǌƝŘȅ ȊŀőƝƴŀƧƝ ǘŜőƪƻǳ α.άΦ bŀǇƛǑǘŜ ǘŜŘȅ ǘŜőƪǳ ŀ ƻōƧŜǾƝ ǎŜ 

ƴŀōƝŘƪŀ ǎ ƴłȊǾŜƳ ǘǌƝŘȅΣ ƪǘŜǊȇ ƧǎǘŜ ȊŀŘŀƭƛ ǇǌŜŘ ŎƘǾƛƭƪƻǳΦ LƴǘŜƭƭƛ{ŜƴǎŜ ǎƛ ǇŀƳŀǘǳƧŜΣ ȌŜ ƧǎƳŜ 

ǇǌŜŘǘƝƳ ȊŀƭƻȌƛƭƛ ǘǳǘƻ ǘǌƝŘǳΣ ŀ ǘŜř ƴłƳ Ƨƛ αǇǌƛǇƻƳƝƴłάΦ tƻǎǳƶǘŜ ǎŜ ƴŀ ƴłȊŜǾ ǑƛǇƪƻǳ Řƻƭǻ 

a ǎǘƛǎƪƴŠǘŜ Enter. 

Á ½ŀŘŜƧǘŜ ŘŀƭǑƝ Enter ŀ ǎƭƻȌŜƴƻǳ ȊłǾƻǊƪǳ { . 

Á ±ȅǎƪƻőƝ ŘŀƭǑƝ ƴŀōƝŘƪŀ ǎŜ ǾǑŜƳƛ ŘƻǎǘǳǇƴȇƳƛ ǾƭŀǎǘƴƻǎǘƳƛ ƪŀǎƪłŘƻǾŞƘƻ ǎǘȅƭǳΦ bŀǇƛǑǘŜ co  

a ǳƪŀȊŀǘŜƭ ǎŜ Ǿ ǎŜȊƴŀƳǳ ǇƻǎǳƴŜ ƴŀ ŎƻƭƻǊΦ YƭłǾŜǎƻǳ Enter ǘǳǘƻ ǇƻƭƻȌƪǳ ǾȅōŜǊǘŜ ŀ ōǳŘŜǘŜ 

ǾȅȊǾłƴƛ ƪ ȊŀŘłƴƝ ōŀǊǾȅΦ tƻǎǳƶǘŜ ǎŜ ǑƛǇƪƻǳ Řƻƭǻ ƴŀ RedΦ /Ŝƭȇ ǇǌƝƪŀȊ ǳƪƻƴőƝǘŜ ǎǘǌŜŘƴƝƪŜƳΦ 

Á YƭłǾŜǎƻǳ Enter ǾƭƻȌǘŜ ŘŀƭǑƝ ǌłŘŜƪ ŀ ƴŀǇƛǑǘŜ fo Σ ǑƛǇƪƻǳ Řƻƭǻ ǎŜ ǇƻǎǳƶǘŜ ƴŀ font - family  

a ȊŜ ǎŜȊƴŀƳǳ ǾȅōŜǊǘŜ ǇƻƭƻȌƪǳΣ ƪǘŜǊł ȊŀőƝƴł Arial . 

Teř ƳłƳŜ ƴŀ ǾȊƻǊƻǾŞ ǎǘǊłƴŎŜ ƴŠƪƻƭƛƪ ǇǊŀǾƛŘŜƭ ŀ ōȅƭƻ ōȅ ǾƘƻŘƴŞ ƧŜ ǎƭƻǳőƛǘ Řƻ ŜȄǘŜǊƴƝƘƻ ǎƻǳōƻǊǳ ǎŜ 

ǎǘȅƭȅΦ ½ŀ ǇǊǾŞ ǘƝƳ ǾȊƻǊƻǾƻǳ ǎǘǊłƴƪǳ αǳƪƭƛŘƝƳŜά ŀ Ȋŀ ŘǊǳƘŞ ȊǇǌƝǎǘǳǇƴƝƳŜ ǘŀǘƻ ǇǊŀǾƛŘƭŀ ƧƛƴȇƳ 

ǎǘǊłƴƪłƳΣ ƪǘŜǊŞ ōȅ ƧŜ ƳƻƘƭȅ ǾȅǳȌƝǾŀǘΦ 

Á ±ǊŀǙǘŜ ǎŜ Řƻ ȊƻōǊŀȊŜƴƝ ƴłǾǊƘǳ ŀ aktivujte podokno Manage Styles  ǾǇǊŀǾƻ ŘƻƭŜΦ aŠƭƻ ōȅ 

obsahovat 4 styly. 

 
Á ±ǑƛƳƴŠǘŜ ǎƛ ōŀǊŜǾƴŞƘƻ ǊƻȊƭƛǑŜƴƝ ǇƻƭƻȌŜƪ Ǿ ǎŜȊƴŀƳǳΥ ǇǊǾƪȅ Ƨǎƻǳ ƳƻŘǊŞΣ id őŜǊǾŜƴŞ ŀ ǘǌƝŘȅ 

ȊŜƭŜƴŞΦ YǊƻǳȌŜƪ ƻƪƻƭƻ ōŀǊŜǾƴŞƘƻ ǇǳƴǘƝƪǳ ǌƝƪłΣ ȌŜ ǎŜ ǘŜƴǘƻ ǎǘȅƭ ǇƻǳȌƝǾł Ǿ ŀƪǘǳłƭƴƝƳ 

dokumentu. 

Á 9ȄǘŜǊƴƝ ŘƻƪǳƳŜƴǘ /{{ ǾȅǘǾƻǌƝǘŜ Ǿƻƭōƻǳ &ÉÌÅ ˲ .Å×ƛ ˲ #33. 
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Á Vyberte File > Save  a pojmenujte dokument site.css . 

Á ±ǊŀǙǘŜ ǎŜ Řƻ ŘƻƪǳƳŜƴǘǳ site.master Σ Ǿ ǇƻŘƻƪƴŠ Manage Styles  ǾȅǾƻƭŜƧǘŜ ǘƭŀőƝǘƪŜƳ 

!ÔÔÁÃÈ 3ÔÙÌÅ 3ÈÅÅÔƛ ŘƛŀƭƻƎ ŀ Ǿ ƴŠƳ ǾȅƘƭŜŘŜƧǘŜ ŀ ǾȅōŜǊǘŜ ǇǊłǾŠ ǾȅǘǾƻǌŜƴȇ ŘƻƪǳƳŜƴǘΦ 

 
Á {ǘȅƭȅ ǎŜ ǇǌŜǎǳƴƻǳ Řƻ ǘƻƘƻǘƻ ŘƻƪǳƳŜƴǘǳ ǘŀƪΣ ȌŜ ƧŜ Ǿ ǇƻŘƻƪƴŠ Manage Styles  ǾǑŜŎƘƴȅ 

ƻȊƴŀőƝǘŜ ŀ ǇǌŜǘłƘƴŜǘŜ ƧŜ ƳȅǑƝ ƴŀ ƴłȊŜǾ ǎƻǳōƻǊǳ site.css . 

 
Á Chcete-ƭƛ ǎƛ ƻǾŠǌƛǘΣ ȌŜ ǎŜ ǘƻ ǇƻǾŜŘƭƻΣ ǇƻŘƝǾŜƧǘŜ ǎŜ ƴŀ ƪƽŘ ǎǘǊłƴƪȅ site.master . Blok stylu 

ōȅ ǘŜř ƳŠƭ ōȇǘ ǇǊłȊŘƴȇ όŀƭŜ ƴƛƪƻƭƛǾ ƻŘǎǘǊŀƴŠƴȇΣ ƳŠƭ ōȅ ǘǳ ȊǻǎǘŀǘΣ ǇǊƻǘƻȌŜ ƧŜǑǘŠ ƳǻȌŜ ōȇǘ 

ȊŀǇƻǘǌŜōƝύΦ 

ρςȢ (ÙÐÅÒÔÅØÔÏÖï ÏÄËÁÚÙ ÎÁ ÓÔÙÌÙ 

Á .ŠƘŜƳ ǇǊƻŎŜǎǳ ōǳŘƻǾłƴƝ ǎǘǊłƴŜƪ ƳǻȌŜǘŜ ǾȅǘǾƻǌƛǘ ǎǘƻǾƪȅ ǇǊŀǾƛŘŜƭ ŀ ƴŀǾƛƎŀŎŜ ƳŜȊƛ ƴƛƳƛ ǎŜ 

ƳǻȌŜ ȊƴŀőƴŠ ȊƪƻƳǇƭƛƪƻǾŀǘΦ 


